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About the DME app and 

its maker 
Welcome to the DME App User Guide for Apple iOS. This guide is a 

description of the DME app. 

With the DME app you can use your smartphone to get secure 
access to your corporate mailbox, including email, calendar, to-dos, 

etc. You can use the DME app if your company has installed the DME 

server component, which can talk to your company's collaboration 
system (Microsoft Exchange or IBM Lotus Domino). The information 

is synchronized, meaning that if you for instance create a calendar 

appointment or an email from your device, it will appear in Outlook 

or Lotus Notes on your desktop as well (and vice versa). 

With DME AppBox, which is part of this app, your company may 

extend the functionality of your DME app further, and even access 

files on the corporate network. More about that later in this guide.  

The DME app is published by Soliton Systems. This is our logo and 

contact information: 

 

Soliton Systems Europe 
Spotorno Allé 12 

2630 Taastrup 

Denmark 

Website: Soliton website http://solitonsystems.com/ 

Some legal stuff: 

DME is trademark of Soliton Systems. 

Microsoft SQL Server®, Microsoft Exchange, Outlook®, Windows, 
Windows Server® 2003/2008/2012, and Active Directory® are 

trademarks or registered trademarks of the Microsoft Corporation 

in the United States and other countries. 

Lotus Notes® and Domino® are trademarks or registered 
trademarks of IBM Corporation, registered in the U.S. and other 

countries. 

Apple™, Apple iPhone™, iPod touch™, and iPad™ are 

trademarks or registered trademarks of Apple Inc., registered in 

the U.S. and other countries. 

http://solitonsystems.com/
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All other trademarks are property of their respective owners. 

DME is in part developed and sold under license from Good 

Technology. 

 

About this guide 

A lot of what the app does will be obvious, and won't need much 

explanation. The purpose of this guide is to tell you the essentials 
about the DME app - how to install it, log in, move around, and exit 

the app - and also to tell you about some of the things that are not 

obvious from what you see on your screen. 

We assume that you are using at least version 5 or later of Apple iOS. 
The DME app will run on versions down to 4.2, but some features will 

be unavailable. Yes, we are fully compatible with iOS 7. You can check 

your version of Apple iOS by tapping Settings > General > About 

on your device and look in the field Version. 

For up-to-date information about what versions of your device 

operating system are supported by DME, see the DME Resource 

Center 

http://resources.excitor.com/support/supported-client-platforms. 

This version of the guide applies to version 4.6 of the DME app. 

One more thing: When we say device in this guide, we mean your 

phone or tablet. 

Nobody's perfect. If you find any problems in this guide, please tell us. 

See Getting help: Help desk and support on page 124 for 

information about how you can do that. 

Some more legal stuff: 

Copyright © 2007-2017 Soliton Systems. 

All rights reserved. 
Due to continued product development, this information may 

change without notice. The information and intellectual property 

contained herein is confidential between Soliton Systems and the 
client, and remains the exclusive property of Soliton Systems. 

No part of this publication may be reproduced, stored in a 

retrieval system, or transmitted in any form or by any means, 
electronic, mechanical, photocopying, recording or otherwise 

without the prior written permission of Soliton Systems. 

 

http://resources.excitor.com/support/supported-client-platforms
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Getting it: Download and 

install 
To install DME on Apple devices, you either have to get the DME app 

from App Store like any other app, or you can become enrolled with 
your company's Mobile Device Management system and get it from 

there. This is up to your company to decide. Enrollment is described 

in more detail below. 

Introducing: The DME Administrator 
The DME Administrator (or DME Admin for short) is going to be 

an important person in your life! The DME Admin is the person 

(or group of persons) in your company responsible for the running 
of the DME system. He or she makes sure that you can stay 

connected with your office systems. In other words - if you get an 

email or other message from the DME Admin, it is a good idea to 

do what it says. 

To get the DME app from the App Store, 

1. Open the App Store app on your device, and use the search 

function to find DME. If the search function comes up with both 

DME and DME 4, pick the DME 4 version. Its icon looks like 

this: 

 

2. Tap the FREE button. The button transforms to an Install 

button. 

3. Tap Install. Enter your Apple ID password when prompted, and 

wait for the app to download. 

You could also download the DME app using iTunes on your PC or 

Mac, and then synchronize DME to your Apple device. 

The first time you start the DME app, the Apple operating system will 
ask if you want to allow notifications for this program (DME). You 

should allow this in order to receive notifications of new e-mails etc. 

See more at Getting told: Notifications and synchronization on 

page 27. 

For more about enrolling your device, see Enrollment with 

MobiControl on page 7 and Enrollment with DME on page 11. 
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Enrollment with MobiControl 

With version 4.2 of the DME server component came an optional 

integration with the Mobile Device Management (MDM) system 

MobiControl from the company SOTI. 

If your company has installed MobiControl, they will want you to 

enroll your device with MobiControl. This means that an MDM 

certificate will be installed on your device, which gives MobiControl 
permission to manage your device and perform certain actions on it. 

For instance, if your device is lost or stolen, they can send a command 

to wipe the contents of your device. And much more - see the 
documentation from MobiControl if you want to know what 

MobiControl can do. 

If your company does not use MobiControl, you can skip this section. 

If MobiControl and DME are integrated, your device must be enrolled 

with MobiControl before the DME server component will accept any 
connection from your device. So, to install DME, you first have to 

enroll with MobiControl. 

The process is a bit different between MobiControl versions 10 and 

11: 

 If you received an 8-digit Enrollment ID from your Admin, go to 

MobiControl version 10 on page 8 for instructions. 

 If you received an Enrollment URL from your Admin, go to 

MobiControl version 11 on page 9 for instructions. 

When the MobiControl app and the App Catalog have been installed 

on your device, open the App Catalog app on your device. Using 
MobiControl, your DME Admin can build a script that makes 

installing DME from the App Catalog easy. 

The App Catalog contains a list of apps permitted or required by 

MobiControl. DME 4 will probably be listed as a Mandatory 

application in the App Store Applications section. 

1. Tap the Free button to install DME. 

  

DME is downloaded from App Store and installed. 
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If your device is running iOS 7.x, this is all you have to do. In the 

installation process, DME will be configured with your user name 

and the correct server path (see Server path on page 21). 

If your device is running iOS 6.x, you need to go back to the App 

Catalog app after installing DME. Then, 

2. Tap the DME icon. 

3. Tap the green Configure button. 

 

DME opens, and is configured automatically. 

 Install DME prompt 

When DME is listed as a mandatory application, and you do not install 
it, MobiControl will show a friendly message such as the following at 

regular intervals: 

 

Tap Install to install DME. 

 

You can now use the DME app for as long as you are enrolled with 

MobiControl. 

Please note: If you are using S/MIME or Notes encrypted e-mail, 

you need to enter your private key password as soon as you can 

after logging in. For more about this, see Private key password on 

page 21. 

 

MobiControl version 10 

1. Go to Apple App Store, and search for MobiControl. 

2. Install the app (it is free). 

3. Launch the MobiControl app on your device. 
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1. Enter the 8-digit Enrollment ID which your Admin has 

communicated to you, and tap Continue. MobiControl then 

opens Safari and guides you through a two-step process, in which 

you follow the on-screen instructions to 

 Install profiles (MobiControl Device Enrollment and 

MobiControl Trust Profile) 

 Enter credentials (your network username and password) 
 Enter your device PIN code for added security 

 Accept warnings 

 Possibly accept terms and conditions 

 Accept push notifications from MobiControl 

When MobiControl is installed, and your device has been enrolled, 

you are ready to install DME. 

For more about this, go back to Enrollment with MobiControl on 

page 7. 
 

MobiControl version 11 

1. Tap the Enrollment URL link which the DME Admin has 

communicated to you, and enter your AD (network) credentials.  
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2. Tap Step 1 to install the MobiControl Trust Profile. 

 
During this step, you need to confirm some prompts and allow 

MobiControl to install the profile. After installation, you are 

returned to the Enrollment Service window in Safari.  

3. Tap Step 2 to install another profile. Accept the warnings, and tap 

Done. 

You are returned to Safari. You are asked to copy the Enrollment 

ID, as this is necessary on some devices for the next step. Accept 

a prompt to install MobiControl when it appears. 

 
4. When you accept the prompt, MobiControl installs the 

MobiControl app on your device and launches it. On some 
devices, you are asked to paste the enrollment ID you copied in 

the Safari screen (above) and insert it in the MobiControl 

activation screen. On some devices, this is done automatically:  

 

5. Tap Enroll. The enrollment is now complete. 
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You are now ready to install DME. 

For more about this, go back to Enrollment with MobiControl on 

page 7. 
 

Enrollment with DME 

If your company has not installed MobiControl, or the DME server 

component version is less than 4.2, you can still enroll the device if 
you are told to do so by the DME Admin. In this case, you enroll the 

device directly with DME. To do this, you need to install DME and log 

in for the first time as described in Getting in: Logging in on page 

17. If you are not going to do this, you can skip this section. 

After logging in, select the MDM Enrollment option in the Tools 

menu to initiate an Apple MDM Enrollment of your device with the 

DME server component. MDM gives the DME Administrator the 
ability to securely configure and update settings, monitor compliance 

with corporate policies, and remotely wipe or lock your device in 

case it is lost or stolen. 

The MDM Enrollment option will disappear from the menu after 
you have selected it. So when you select the option, you must 

complete the enrollment process. If the MDM enrollment process is 

interrupted along the way, for instance due to the Internet 
connection being lost, please contact your DME Administrator for 

information about how you can repeat the enrollment process.  

When you select this option, the DME app will first ask you if you are 

sure you want to enroll the device: 

 
If you tap Yes, DME will check the Wi-Fi address (also known as the 

MAC address) of your device. The Wi-Fi address is used as a unique 

identifier for your MDM-enrolled device on the DME server. 

If you are upgrading DME from version 4.1.3 or earlier, and your 

device is running iOS 7, the DME app will not be able to find the WiFi 

address on its own due to new restrictions in iOS 7. In this case, you 
will need to enter the Wi-Fi address yourself. To do so, please follow 

the guidelines for copying and pasting the Wi-Fi address in the section 

Pre-registered devices, DME, and iOS 7 on page 14. 
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When the Wi-Fi address has been entered, DME will perform a full 

system info sync with the server component, and then open Safari at 
the address <SERVERPATH>/mdm (where <SERVERPATH> is the path to 

the DME server component, including port - see Server path on page 

21). If the DME server has been set up correctly, this link enables you 

to complete the enrollment procedure: 

1. Log in to DME. Use the same login credentials as you use for the 

DME app. 

 

2. Then complete the steps described in the following section - see 

Installing Apple MDM profile on page 12. 
 

Installing Apple MDM profile 

The DME Apple MDM Enrollment web page contains instructions 

and two links: 

 
1. First tap link no. 1 to install the DME Apple MDM root certificate 

on the device. This root certificate is self-signed and 

auto-generated by DME for the purpose of signing any profiles 

distributed by DME, including the main MDM profile. If the user 
omits this step, all profiles distributed by DME will be Unsigned 

(but still valid). 

After tapping the link, tap the Install button and complete the 

installation. 
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2. To complete the enrollment, go back to the DME Apple MDM 
Enrollment web page and tap link no. 2 to install the DME 

Mobile Device Management profile. This will establish a trust 

between server and device, enabling the silent installation of 
configuration and provisioning profiles and the execution of MDM 

actions. 

After tapping the link, the user should complete the installation 

process. 

Please note: On some devices, the certificate appears to be Not 
trusted and Unsigned. This is due to a quirk in iOS and has no 

practical importance for the security of DME. 

  
When tapping Install, the DME MDM server and the device will 

communicate using a protocol called SCEP. It will proceed through 

the following actions: 
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Finally, the following screen is shown to indicate that the 

installation is complete. 

 
Tap Done. You can see the profiles in Settings > General > 

Profiles on the device. 
 

Pre-registered devices, DME, and iOS 7 

You need only read this section if you are installing DME on a new 

device running iOS 7, and the DME admin requires you to enter 

information about the device after installation. 

Some organizations will only allow known devices to be created as 
devices in DME. To accomplish this, the DME administrators create a 

list of pre-registered devices and set an option on the DME server that 

tells DME to look at the list for a match before creating the device in 
DME. DME checks the list whenever an as yet unknown device tries 

to connect with DME. 

The DME administrators need a unique identifier for each device - a 

device ID. For some device types this could be the IMEI number. 
However, Apple devices do not disclose their IMEI number. 

Therefore they use the device MAC address (the Wi-Fi Address). This 

works fine with iOS devices up until iOS 7, because DME was able to 
retrieve the Wi-Fi Address from the device and present it to the DME 

server as device ID. The DME server could then match that against 

the list of pre-registered devices, and allow it to be created (or reject 

it). 

However, in iOS 7 it is no longer possible to retrieve the Wi-Fi 

Address automatically from the device. Therefore, if the following 

conditions are present: 
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 Your device is running iOS 7, 

 Your DME administrators require that the device is pre-registered 

before allowing it on to the DME server component, and 

 You have never been connected with DME using this device 

(before upgrading to iOS 7) 

-then the following message will appear on your device after you have 

entered your network credentials and tapped Login: 

 

When you tap Enter Wi-Fi address, the following screen is shown. 

 

Press the Home button to put DME in the background. Then 

1. Open your device Settings. 

2. Choose General > About. 

3. Scroll till you find the field Wi-Fi Address. 

4. Long-press the field label, until the Copy button appears. 

5. Tap Copy to copy the Wi-Fi Address. 

6. Double-press the Home button, and tap DME to go back to DME. 

7. Double-tap inside the field, and Paste the Wi-Fi Address. 

8. Tap Done. 
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DME will now verify if the Wi-Fi Address you pasted into the field is 

on the list of devices that are permitted access to DME. If successful, 
you are presented with the Login screen again, and you can log in as 

normal. 
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Getting in: Logging in 
Now the DME app has been installed, and you can start the app. You 

will find that you need to log in. The first time you log in, DME needs 
a bit of information from you. DME will run a small wizard to get this 

information. The initial login wizard is described in the next section.  

After that, you'll just need to enter your username and password 

when you start the DME app: 

 
This username and password is the same as you use for logging in to 

your desktop computer. Ask your DME Admin if you are in doubt. 

 If you're using Domino (Lotus Notes), you need to enter your 
Internet password. That is what you use for Notes Webmail 

also. 
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If you have set up a personal unlock pattern, the login screen will look 

like this: 

 
See Phone number and unlock pattern on page 23 for more 

information about the personal unlock pattern. 

If you have set up Touch ID (fingerprint), the login screen will look 

like this: 

 

See Unlock in Tools on page 85 for more information about how to 

set up Touch ID. 
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DME and iOS 7 

Some organizations will only allow known devices to connect with the 

DME server component. To accomplish this, the DME administrators 

create a list of pre-registered devices and set an option on the DME 
server that tells it to look at the list for a match before letting the 

device access the DME server component. DME checks the list 

whenever an as yet unknown device tries to connect with DME. 

The DME administrators need a unique identifier for each device - a 
device ID. For some device types this could be the IMEI number. 

However, Apple devices do not disclose their IMEI number. 

Therefore they use the device MAC address (the Wi-Fi Address). This 
works fine with iOS devices up until iOS 7, because the DME app was 

able to retrieve the Wi-Fi Address from the device and present it to 

the DME server component as device ID. The DME server 
component could then match that against the list of pre-registered 

devices, and allow it to be created (or reject it).  

But with iOS 7, it is no longer possible to retrieve the Wi-Fi Address 

automatically from the device. Therefore, if the following conditions 

are present: 

 Your device is running iOS 7 

 Your DME administrators require that the device is pre-registered 

before allowing it to access the DME server component 

 You have never been connected with DME using this device 

(before upgrading to iOS 7) 

-then the following message will appear on your device after you have 

entered your network credentials and tapped Login: 
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When you tap Enter Wi-Fi address, the following screen is shown. 

 

Press the Home button to put DME in the background. Then 

1. Open your device Settings. 

2. Choose General > About. 

3. Scroll till you find the field Wi-Fi Address. 

4. Long-press the field label, until the Copy button appears. 

5. Tap Copy to copy the Wi-Fi Address. 

6. Double-press the Home button, and tap DME to go back to DME. 

7. Double-tap inside the field, and Paste the Wi-Fi Address. 

8. Tap Done. 

The DME server component will now verify if the Wi-Fi Address you 

pasted into the field is on the list of devices that are permitted access. 

If successful, you are presented with the Login screen again, and you 

can log in as normal. 
 

Initial login wizard 

The first time you start the DME app, you are asked for some 
information. This information ensures that you are directed to the 

right DME server when you log in to the DME app from your device, 

and helps you fill in some useful details. 

The next sections describe the questions you are asked, one by one.  

Note that this may not apply if you installed DME through 
MobiControl. See Enrollment with MobiControl on page 7 for more 

about this. 
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Server path 

The first question in the initial login wizard is about your server path. 
You need to specify the server path to ensure that you are directed 

to the right DME server when you log in to the DME app from your 

device. Otherwise you will not be able to access your email etc.  

 
You need to contact your DME Administrator to know what to put in 

the Host name field. This information has probably been sent to you 
already, or is posted somewhere on your intranet. The path you need 

to enter might look like this: dme.yourcompany.com - a normal 

Internet address. 

You should normally leave the Port number at 5011 and the 

Secure connection enabled - again, do as the DME Administrator 

has told you. 

Now consider if you need to enter a Private key password - see 

the next section. 
 

Private key password 

The next field, Private key password, needs to be filled in if you 

are using Notes encrypted mail or you are using S/MIME encryption. 

If you don't know what that is, and/or you haven't been told to enter 

anything in this field, it is because you don't need to. 

This is what the field means: If you are using Notes encrypted mai l or 

S/MIME, enter the password for your private key in this field. Your 
private key is used for decrypting encrypted messages sent to you, 

and for signing private messages. If you do not enter a password here, 

you cannot read encrypted messages or sign new messages from your 

mobile device. 
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 If your collaboration system is using Notes Encryption, you 

must enter the password for your user ID file. 

 If your collaboration system is using S/MIME, enter the password 
for your private key in this field. You must also upload your 

personal certificate to the DME server (using myDME). 

If you know you have a private key password, you should enter it 

now. If you wait until later, you will need to re-import your email 
after entering the password. Again - contact your DME Administrator 

if you want to know more about this. 

Tap Next to proceed to the next step in the initial login wizard. 
 

First connection 

After tapping Next, the DME app will make its first connection to the 
DME server component. The first connection takes a bit longer time 

that subsequent logins, because a number of tasks are taken care of. 

Here is what the first connection does: 

1. It verifies that you exist as a user in the collaboration system, 

based on the username you entered. 

2. It verifies that you are authorized to log in to the collaboration 

system as that user, based on the password you entered. 

The next time you log in, the authorization will be faster, because 

no connection with the DME server component is required until 
you need to interact with the server component, for instance to 

check for email. 

After a first successful connection with the DME server component, 

the DME app shows the last step of the initial login wizard - asking 

you to enter your phone number and an unlock pattern. 
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Phone number and unlock pattern 

In the last step of the initial login wizard, you are asked to fill in two 

fields. Both these fields can be filled in later, but why not now? 

 

First, you are prompted to enter the phone number of this device. If 
the device does not have a SIM card or a phone module, such as a 

tablet device might not have, then you should not fill in this field.  

The final question is about setting up an unlock pattern. Since DME has 

been chosen as mobile email and app provider, we know that security 
is very important for your company. Therefore you probably have a 

very long and complex network password, which is difficult to enter 

on a mobile device. DME enables you to "translate" this password into 
an unlock pattern - a pattern which you draw on the screen with your 

finger. 

To define this pattern, tap the Set unlock pattern field. 
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Move (swipe) your finger vertically, horizontally, and diagonally across 

at least 4 of the tiles on this screen. Tiles can be used more than once. 
The DME Administrator can decide how many tiles you must at least 

swipe over. Repeat, and your unlock pattern is set. You can use that 

pattern when logging in instead of entering your full username and 
password. See Setting unlock pattern on page 87 for more about 

this. 

If you enter it wrong, twice, when logging in, you will need to enter 

your full username and password. 

As mentioned, you can fill in these fields later - Phone number by 
selecting Settings > General > Phone number, and unlock pattern 

by selecting either  Tools > Unlock, or Tools > Set unlock 

pattern. 

When you tap Done, the DME app will open, and the initial 

synchronization of your data will take place. See the next section.  
 

Initial synchronization 

The DME app will now synchronize your data. Because this the initial 

sync, the app will simply import what you have in Outlook or Notes.  

In Outlook or Notes, you may have many years' worth of emails. The 
DME app will not import all of that - it would take a very long time, 

and your device could probably not handle all that data anyway. The 

amount of data imported by the DME app is limited by choices made 
in Settings. Your DME Administrator has made those choices for 

you, but you may be able to change them yourself. You can limit the 

data you get on your device by setting sync windows, consisting of a 

number of days: 

 Email: Can for instance be set to get your email from the last 10 

days, from your Inbox only. Separate values can be set for 

different email folders. 

 Calendar: For instance 10 days back and 60 days ahead. 

 Contacts: All contacts or none. 

 To-dos: For instance 7 days back and 60 days ahead. 

 Notes (if you are running Lotus Notes): For instance 7 days back 

and 60 days ahead. 

 Feeds: For instance 50 articles per RSS feed. 

Each of these types of data has its own settings. Choose Settings in 

the DME app to access them. 

After the initial synchronization, you can start using your DME app. 
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Getting around: Desktop 

and icons 
This section is a quick look at the DME app - what the Desktop is, 

what the different icons mean, and how to access advanced functions.  

What you see in the DME app is determined by various factors: 

 Your DME Administrator. According to company policy, your 
DME Administrator may have restricted access to certain features. 

For instance, if you can't see your calendar, it is because you do 

not have access to seeing it. 

 Your company's license. If your company has not bought a 
license to synchronize calendar events (for instance), then your 

calendar will not be accessible from the DME app. 

 The DME server component version. Some features are only 

available in the DME app when using the latest versions of the 

DME server component. 

 Collaboration system. A few things are available if you are 

using Exchange and not Domino, and vice versa. This will be noted 

in this guide. 

So if you don't see all that is described here, it is probably intentional. 

But you can ask your DME Admin to let you use more features. 
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The DME Desktop 

When you launch the DME app, you are taken to the DME Desktop. 

From the Desktop, you have quick access to the most commonly used 
features in the DME app - it is like having a number of apps within the 

DME app. Tap the icon to open the associated app. 

 
Apart from these icons, you can use the menu system (the  icon at 

the Desktop) to access all functions in the DME app. 

 Desktop symbols 

Sometimes different symbols are shown on top of the Desktop icons. 

 A green arrow next to an icon means that changes have been made 

in the DME app which have not been sent to the server 

component yet. 

 If an icon appears dimmed, it means that the initial synchronization 

has not been run for that particular feature yet. 

 A badge on the Unread icon shows how many unread emails you 

have. Note that the Unread folder shows unread emails from all 

folders, not just the Inbox. 

 A badge on the Calendar icon shows the number of meeting 

invitations in the Inbox. 

 A badge on the Feeds icon shows the number of unread RSS Feed 

articles. 
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Getting told: Notifications 

and synchronization 
When a change occurs in the collaboration system - for instance, if 

someone sends you an email - the DME server component will detect 
this and try to notify you. This is called a push notification, because it 

is pushed to the device. 

If you allowed notifications from DME the first time you started the 

DME app (recommended - see Getting it: Download and install on 
page 6), an alert will appear on you device when you receive a new 

email. If you tap the alert, the DME app will open and show the email. 

The same goes for calendar items that have been created or updated.  

 Silent notifications 

In fact, DME usually sends you two notifications. The first one is silent 

- meaning that you won't see it, but DME will. The silent notification 
makes DME synchronize your mailbox in the background. That way, 

the mailbox will be updated and ready when you get the regular 

notification. 

However, this does not always work, because sometimes the iOS 
operating system will disregard silent notifications - possibly due to 

battery concerns. That is why you sometimes have to wait a little 

while for DME to synchronize your mailbox, after tapping a 

notification alert. 
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 Notification Center settings 

With iOS 7, you can change how notifications appear. Go to your 
device Settings > Notification Center > DME 4. Here you can 

adjust a number of things: 

 
 The way in which the alerts are shown (by default the are shown 

as a banner along the top edge of the device screen) 

 Whether you want the DME app icon to display badges (number 

of unread emails) 

 Whether you want the device to play a sound when the alert is 

shown 

 Whether you want the alerts from DME to be visible in the 

Notification Center (which is show when you pull down from the 

top of the device screen) 

 If you want to show alerts in the Notification Center, how many 

of them do you want to show at a time (1, 5, or 10) 

 Whether you want to show alerts on the Lock Screen 

These settings are controlled by the Apple operating system and are 

not part of DME. 

 

 In the DME app, you can set up some aspects of notifications - such 

as the alert sound and volume. See Email settings on page 116 and 

Calendar settings on page 118 settings. 

Note that notifications may be disabled in the DME server 

component. 
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In the next sections, you can read more about synchronization and 

what is really going on. 
 

Synchronization 

The basic idea of the DME app is to make sure that the emails, 

appointments, contacts, and other items that you see on your mobile 
device completely match the corresponding items on your desktop or 

laptop computer. The business emails, appointments, and contacts on 

your computer are managed by the collaboration system - Microsoft 
Exchange™ or IBM Lotus Domino™, and you typically work with 

these items using the Microsoft Outlook™ or Lotus Notes™ 

applications on your computer. 

To keep things synchronized (in sync), DME keeps checking the 

following on both the device and on the server: 

1. Have any items been created? An item could be an email, a contact, 

an appointment or meeting, a to-do, or possibly a note (if you are 

using Lotus Notes). If an item has been created, it is copied to the 
system on which it does not yet exist (for example, if an email is 

created and sent from the mobile device, the email will appear in 

the Sent folder in Outlook or Notes also). 

Furthermore, items on the mobile device are kept synchronized 
within a certain time span. This is called the synchronization window. 

For instance, the settings may specify that the email app should 

show emails from the last 7 days. The sync process will then 
remove emails older than 7 days from the Inbox and other 

mailboxes (except Drafts) on the mobile device. 

You can always search for emails even if they have been removed 

because of the sync window. 

2. Have any items been deleted? If an item, for instance an 
appointment, has been deleted in the collaboration system, it will 

be removed from the mobile device as well. Note that deleting 

emails on the server will not cause a notification on the device. 

3. Have any items been edited? Some items can be modified. If you for 
instance edit a contact on the device, the change will be 

synchronized to the collaboration system (and vice versa). 
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Sync methods 

The most common way to synchronize items is simply to let the 

server component handle it. This is called push sync. 

 Push sync 

Whenever someone sends you an email, a meeting invitation, or 
similar, it is received by the collaboration system (Microsoft 

Exchange or IBM Lotus Domino). The DME server keeps 

monitoring the collaboration system for such updates, and sends a 
notification to the mobile device on which the DME app is 

installed. The notification is picked up, read, and then removed 

again by the DME app, and a sync is started to make the DME app 

match the change in the collaboration system. 

Push sync is enabled and scheduled by the DME administrator. A 

push can also be sent in this way when system settings are 

updated, or a server command is issued. 

In the same way, when you send an email or update your calendar, 
the DME app will immediately connect with the server component 

and send the change in. When it does, it will automatically receive 

any new items or updates from the server component, without 
notification (more about this command stack at the end of this 

section). Note that the setting Send immediately controls if 

your email is sent at once or if it is queued for later - see Email 

settings on page 116. 

 Manual sync 

You can also make DME synchronize manually - for instance if the 

Send immediately setting is off. When you do this, the DME 

app will send in all changes to the server, and then wait for the 

server to send any updates back. You can do this in several ways: 

 From the top of the list in an e-mail folder, drag down and 

release (Twitter-style sync.). 

 From Calendar, Contacts, To-dos, and Notes, select the 

Synchronize option. 

From the Desktop, tap the Synchronize button at the top to 

synchronize all resources at once.DME wants to make fast and 

efficient use of the available bandwidth. For this reason the DME 
server component builds a list of commands to be executed by the 

DME app the next time it connects with the server. This is called a 

command stack. When the app connects with the server, for instance 
in order to synchronize email, the server will tell the DME app to 

execute those commands as well. For this reason you may experience 

that, for instance, the manual email sync you requested is followed by 
a calendar sync - meaning that the server takes the opportunity to 

update your calendar because a change has occurred. 
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Sync conflicts 

In some cases, a sync conflict may arise - for instance, if an 

appointment has been moved to another time on both the 

collaboration system and the mobile device. DME will resolve this 
conflict by moving the meeting to the time indicated in the DME app, 

and a message will be sent to you with information about this.  

Also, the first time the DME app is synchronized, or after an app reset, 

duplicate contacts or calendar items may occur. In this case, the 
duplicate entries will be created, and an email listing the duplicate 

entries will be sent to you by the DME server component. 
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Getting work done: Email, 

calendar, and more 
This section tells you about how to make the day-to-day experience 

of working with the DME app a great one. We begin with the Email 

app. 
 

Email 

Tap the  icon from the Desktop to open the Email app. The 
Inbox now displays the emails and meeting invitations that have been 

synchronized to the client. 

The Inbox looks something like this on a regular device. On a tablet, 

it looks different - see DME on tablets on page 33. 

 
Along the left side of the mailbox view, one or more icons may be 

displayed. The icons quickly tell you quite a bit about the email:  

 An unread email is shown with an orange dot. When you've read 

the email, the dot is removed. 
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The email has been replied to. 

The email has been forwarded. 

 The email has been flagged. 

 This icon after the Sender name indicates that the email or 

meeting invitation contains one or more attachments. 

 This email is a meeting invitation. See Responding to invitations 

on page 62 for more information. 

! An exclamation mark and the subject in a red color indicates that 

the message was sent with high importance. 
 

DME on tablets 

Soliton Systems does not make a separate app for the iPad/iPad mini 

and the iPhone/iPod - they all use the same app. 

When describing DME in this guide, we use the iPhone as a starting 

point. When running on the iPad, the app is the same - only the layout 

is different. These are the main differences. 

 Desktop 

The icons used on the Desktop match the current platform, so 
iPad icons are bigger than on iPhones, and devices with Retina 

display use icons in a higher resolution. 
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 Folders and Inbox 

When you open the Inbox in Landscape mode, iPad shows a 

three-pane view of your mailbox: 

 

Folders are shown to the left, the email list at the top right, and 

an email preview at the bottom right. In Settings, you can decide 

if showing an email in the Preview pane should mark the email in 

question as read - see Email settings on page 116. 
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In Portrait mode, DME shows you e-mails as a two-pane view with 

e-mails at the top and the Preview pane at the bottom. To go to a 
different folder, tap the Folder icon at the top, and select the email 

folder you want to see: 

 
Meeting invitations received are not displayed in the Preview pane 

on the iPad. Instead, a button with the text Open invitation is 

displayed. 

To read an email in full screen, just double-tap the email in a folder. 

Those are the main differences between the DME app on iPad and on 

other iOS devices. 
 



DME App User Guide 

Getting work done: Email, calendar, and more 
 

36  © 2017 Soliton Systems 

 

Checking email manually 

To check for new email, drag down and then release to synchronize 

the mailbox (like Facebook or Twitter): 

 

For more information, see Synchronization on page 29. 

Note that you usually do not have to synchronize manually. Emails, 
meeting invitations, and commands are pushed to the device instantly 

from the DME server using Apple Push. However, you may have to 

perform a manual sync in this way if you own multiple devices with 
DME installed, as the push will only hit one device (the one that was 

synchronized last). 
 

Reading email 

Tap an email in a folder to read it. As you can see from the 
illustration below, the email screen is divided into three areas: the 

information area, the text area, and the action area. 
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The information area shows you the subject of the email, the date and 

time it was received by the collaboration system (Exchange or 
Domino), if there are any attachments with the email, and who it is 

from. If you tap Details, you can see all recipients of the email. 

The text area shows the email itself. Here, you can pinch together and 

apart to change zoom level (making the text smaller or larger). 

Double-tap to go back to default zoom level (100%). 

The illustration above shows an email with pictures and rich text 

formatting. Images in an email may compromise your privacy. A 

message will say so and prompt you to download the images if you 
deem it safe. An email with pictures might look like this before you 

choose to download the images: 

 
Tap the gray area to download the pictures. The DME Administrator 

may have disabled the possibility of downloading images completely. 

Images that are embedded into the email are always downloaded, 
however, because they have already been through the collaboration 

system's security checks. 

The action area contains functions that apply to the email you are 

currently reading: Delete, Move, Mark or Flag, and Reply. These 

actions will be discussed over the next sections. 
 

Email links 

Emails and meeting invitations may contain information such as email 

addresses, phone numbers, and web addresses. Whenever such 
information is found, it is written in blue and underlined as a link. Tap 

a link to see your options for the link: 

Phone number links 

When you tap a phone number, you can select Add to contacts, 

Call, or Create SMS. 
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 Call lets you dial the number. This naturally only applies to 

iPhone, not iPad touch or iPads with no phone module. 

 

  

A note about international calls: If a phone number is preceded by + 

or 00, DME will remove any initial 0 in the first set of parentheses 

from the number before dialing it. Otherwise, it will be dialed as it is. 

For instance: The number (012)-555-23421 will be sent to the phone 
dialer as is. The number +44(012)-555-23421 will be sent to the dialer 

as +44(12)-555-23421. This is in compliance with international 

standards. 

 

 Create SMS lets you create a new text message for the person 

in question. 

 Add to contacts copies the highlighted phone number, and 
opens your Contacts. Here you can choose between the following 

options (shown immediately if you are using a device without a 

phone module): 

 
 Create new Contact creates a new, empty contact, inserting 

the phone number in a phone number slot. You can now edit 
the contact further (see your Apple documentation). 

 Add to Existing Contact lets you browse for an existing 

contact to which you want to add the information. 
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Email address links 

When you tap an email address, you can choose between the following 

options: 

 
 New e-mail - create a new email for the email address you 

tapped. 
 Add to contacts - gives you the same options as tapping a 

phone number (see above). 

 Call - If the email address is found to belong to one of your 
contacts, a call will be placed to the person in question, if a 

phone number is found for the contact. If several phone 

numbers are listed for the person in question, you will be 

prompted to select which number to use. 

 

Web links 

When you tap a web address, the website is opened in the secure 

browser in DME AppBox. 

  

If you do not have access to DME AppBox, DME will check the link to 
see if it is a SmartLink, and open it as such. A SmartLink is a special 

type of link which allows you to access documents on an intranet 

server. This functionality is being replaced by DME AppBox. If the link 
is not a SmartLink, it will be opened in the Safari web browser. For 

more information about DME AppBox, see DME AppBox on page 

94. 
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Email functions 

For every email in the DME app, a number of functions are available. 
Below is a list of the functions and options that are available, and 

where you can choose them from. Note: Edit in the last column in 

the table below means mailbox edit mode. To enter Edit mode, tap the 

Edit button at the top right of any mailbox: 

 

Then select any number of emails, and choose the function you want 

to carry out on them, or choose Cancel to leave Edit mode. 

The following functions are available: 

 

Function/Option 

Available from open 

email 

Available from 

mailbox list view 

Delete  Swipe left, or Edit > 

 

Move to another folder  Edit >  

Mark read/unread > Mark Edit >  

Flag > Flag Edit >  

Reply / Reply to All  > Reply  

Forward  > Forward  

Create meeting  > Create meeting  

Read previous email   

Read next email   

See also Folders on page 47 and Responding to email on page 45. 
 

Creating an email 

 Creating and sending an email 

1. To create a new email, first tap the  icon on the Desktop to 

go to the Inbox. 

2. Then tap  to open a new email form. 

3. Enter recipients as described in Selecting recipients on page 42. 
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4. Enter a subject. 

5. Write the email. There are some tips about this in Writing text 

on page 43. 

6. Choose email options (priority, encryption and signing) - see 

Selecting message options on page 44. 

7. Add an attachment if required - see Adding attachments on page 

52. 

8. Tap Send in the top right corner. 

Tapping Send saves the email in the Outbox. Depending on settings, 

the email is sent immediately or queued for the next synchronization 
(see Email settings on page 116). When the email has been sent, it is 

moved to the Sent folder on your device. 

If you have started writing an email, and you want to continue writing 

at a later time, you can save the email as a draft. 

 Saving an email as a draft 

1. Close the email by tapping Cancel, and select Save when asked if 

you want to save as draft. 

The email is saved to the Drafts folder, and you are returned to the 

mailbox. When you want to finish the email, you can open it from the 

Drafts folder, edit it, and send it in the usual way. 

If you are interrupted when writing an email, for instance if you 

receive a call, the email is automatically saved as a draft. When you 

open the DME app again, you are returned to the screen from which 

you were interrupted. 

 mailto scheme 

On iOS, the DME app can also be used from other apps for sending 
emails. This is done by using a special url scheme, which the DME app 

will handle. The url scheme is dme://, which is added in front of the 

standard mailto: scheme. The following is an example of a HTML 

snippet that opens a new email in the DME app from a Safari web 

page, complete with a recipient and a subject: 

<a href="dme://mailto:name@example.com?Subject=Comment 

from webpage">Send comment</a>  

Tapping the link opens the new email in the DME app in edit mode. 

The protocol scheme is registered by the Apple iOS, and is available 

to all native apps on the device (not just to AppBox apps).  
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Selecting recipients 

To enter recipients for the new email (or participants in a meeting 

invitation), tap the To, Cc, or Bcc field, and start typing a name. 
DME will try to predict who you want to enter as recipient, and 

shows suggestions as you type: 

 

 How type-ahead works 

This list of possible recipients (the type-ahead list) is built from the 
email addresses found in your mailbox folders, from participants in 

meetings where you are a participant or chair, and from those of your 

local contacts that have an email address. 

When you start typing, DME will match the typed characters with the 
names and email addresses in the list of addresses. For instance, 

typing a "c" might match the following entries in the list:  

 "Chris Rea <chris.rea@music.com>" 

 "Hooray Carlton <hooray@freude.de>" 

 "Melanie C. <melc@spice.com>" 

As you type more characters, the list will shrink. In the example 

above, typing an "a" after the initial "c" will limit the list to "Hooray 

Carlton <hooray@freude.de>" only. 

 

Tap a name to enter it into the recipient field. Start typing again to 

add another recipient. 

When a recipient has been entered, it is enclosed in an address 

bubble so it is easy for you to see how many recipients there are:  

 



DME App User Guide 

Getting work done: Email, calendar, and more 
 

43  © 2017 Soliton Systems 

 

To edit an email address, tap a bubble to expand it. You can then edit 

the text. 

Global Address Book search 

If you cannot find the required contact, you can tap the search icon 

 in the recipient field to search the Global Address Book (the 

contacts you share with your company). DME switches to the Global 

Address Book screen, transfers the letters you have already typed in 
the recipient field to the Name search field, and executes the search 

immediately.  

 

Tap a name to insert it into the recipient field. Tap the  button to 

see more details about a person in the list. See Searching for 

contacts on page 79 for more about this. 
 

Writing text 

Write the email as usual. You can add attachments - see Adding 

attachments on page 52. 

Formatting 
Even though you can receive and view emails in HTML format (if 

allowed by the DME Administrator), you can only write new emails in 

plain text (meaning that you cannot apply formatting). However, with 
version 4.2 of the DME server component, all HTML formatting 

(including pictures) in forwarded emails and in replies will be retained, 

and you can edit text within the HTML formatted text. 

Right-to-Left languages 
DME supports the use of Right-to-Left (RTL) languages, such as 

Arabic and Hebrew. 
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When you write in an RTL language, the text of the email will be 

right-aligned. The first letter that you type in a new paragraph 
determines the alignment (the directionality) of the text. This means 

that if you for instance add a new paragraph of English text in an 

otherwise Hebrew e-mail, the English line will be left-aligned. 

If you are using version 4.1 or below of the DME server 
component, the directionality of the text is determined by the first 

letter in the entire email. This means that you cannot mix right and 

left aligned text in your emails. 

 

Selecting message options 

In email composition mode, tap the Details overlay button  to 

open the E-mail options screen. Here you can sign, encrypt, and 

change the importance level of the email. 

 Setting message options 

1. Tap Details in the email you are creating. 

2. Tap the Importance setting you wish to set for this email - Low, 

Normal, or High. 

3. Tap Encrypt to encrypt the email. 

4. Tap Sign to sign the email. To sign an email, your password (for 
either S/MIME or Lotus Notes encrypted e-mail) must be entered 

in the field Private key password in Settings > Security. If it 

is not entered here, DME will prompt you for the password. You 
will not be able to mark the email as signed unless the password is 

entered. If you have questions about this, ask your DME 

administrator. 

 About signed and encrypted email 

Please note the following about signed and encrypted email:  

 When you send a signed email, and the DME server cannot find 

your private key on the server, an email with a notification of the 
error "The DME Server could not send the signed S/MIME email") 

is sent to you by the DME server. Your email will be sent to the 

recipient; however, it will not be signed. 

 When you send an encrypted email, the DME server needs to 
know the public key of each of the recipients of the email. If the 

public key of one of the recipients is unknown to the server, an 

email with a notification of the error ("Cannot find certificate for 
recipient: xx") is sent to you by the DME server. The email will not 

be sent to any of the recipients. 

Using signed and encrypted email requires special setup. Please 

contact your DME administrator. 
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Tap Done to return to the email. 
 

Responding to email 

You can respond to an email by replying to it, forwarding it, or 

converting it to a meeting. Your options depend on whether the email 
was sent to you alone or to multiple recipients, and whether the 

email contains attachments. 

To see the options, open an email, and tap . The following options 

are available: 

 Replying to an email 

1. Open the email, and tap . 

2. Tap Reply (to the sender alone) or Reply to All (to all 

recipients). 

3. If the email contained attachments, you are asked if you want to 

include these in your reply. 

4. Type your reply, and tap Send. 

 Forwarding an email 

1. Open the email, and tap . 

2. Tap Forward. 

3. If the email contained attachments, you are asked if you want to 

include these in the forwarded email. 

4. If the e-mail has HTML formatting, it is retained in the forwarded 

email, and you can edit the HTML formatted text. 

5. Type recipient details and a message, and tap Send. 

 Converting email to meeting 

This feature is a useful shortcut to turning an email conversation into 

a request for a face-to-face meeting. 

1. Open the email, and tap . 

2. Tap Create meeting. 

A new meeting invitation is created. The sender and all primary 

recipients of the email are inserted as Required participants, 
and any Cc recipients are inserted as Optional participants. 

The email Subject is carried over as title of the new meeting. See 

Calendar on page 56 for more about creating appointments. 
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For more about sending emails, see Creating an email on page 40. 

See Adding attachments on page 52 about how to work with 

attachments when responding to email. 
 

Finding email 

Just above the mailbox, there is a search box: 

 
You can use this box to search for emails. When you start typing, the 

number of emails in your mailbox is reduced to only those that 

contain the text you are entering. This text can be found anywhere in 
the email - it can be names in the sender field or the recipient fields, 

or text in the subject or body fields of emails. Emails are only 

searched in the current folder, and not in any subfolders. To search in 

subfolders, first switch to that folder - see Folders on page 47. 

The DME app first searches the emails that have been synchronized to 

the device. If the email you are looking for is not shown in the list, 

you can tap the Search on server... button that is shown 
underneath the bottom email in the search result. This causes the 

same search to be carried out on in the mailbox of your Outlook or 

Lotus Notes. In the search results from the server, only the sender, 
date and subject are returned at first - to see the actual content of 

the returned emails, you have to open them. 

To search for attachments, use the search box in the Attachments 

view. See Managing attachments on page 55. 

 Technical details 

The DME app shows the results in the order in which they are 

presented by the collaboration system. If your collaboration system is 
based on Lotus Domino, the search results are returned in order of 

relevance. If your collaboration system is based on Microsoft 

Exchange, the search results are returned in chronological order (that 

is, by date). 

The server component sets a limit to the number of search results. By 

default, the limit is 100 results. 

For best performance, your mailbox should be indexed. For more 

information about indexing your mailbox, see the documentation for 

Lotus Notes or Microsoft Outlook. 

Note also that if you select a folder which contains other folders, you 

will get different results depending on your collaboration system: 
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 If you use Domino, the search for emails will be performed in the 

selected folder only. 

 If you use Exchange, a message will be shown: "Do you wish to 
include subfolders in your search?" If you answer Yes, emails in 

the subfolders of the selected folder will be searched as well.  

 
 

Sorting email 

Tap  at the bottom of a email folder to sort the email folder in 

question. You can sort by: 

 Date - ascending or descending (default) 

 Sender - ascending or descending 

 Subject - ascending or descending 

 Flag status (flagged items at the top) 

 Priority (higher-priority at the top) 

The default sort order can be changed in Email settings on page 116. 
 

Folders 

The DME mailbox consists of at least the following folders: Inbox, 

Outbox, Drafts, Sent, and Unread. These are called the DME system 

folders. The first four of these folders function like their counterparts 
on the collaboration system (Notes or Outlook). The Unread folder 

is a smart folder which shows all unread messages in any mail folder in 

DME. When an email in the Unread folder is read, it is removed from 
that folder - but naturally remains in the folder where it is actually 

located. 

Apart from these system folders, subfolders created on the 

collaboration system are also shown in the DME app. However, 
emails in these folders are only shown if you enable synchronization of 

emails in the folders (see Folder settings on page 117). With settings 

similar to email settings (see Email settings on page 116), you can 
specify how many emails you want to see in each folder (by age in 

days) and whether you want to synchronize emails in folders at all. 

This setting will apply by default to all folders. You can also specify 
different settings for each folder, including whether you want to 

receive a notification when a new email arrives in a folder, as 

described in the following section. 
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You cannot create, move or delete folders in the DME app. You can, 

however, move emails between folders (see Email functions on page 
40). When you do this, the move will be reflected in Outlook or 

Notes as well. 
 

Viewing folders 

To see all mail folders, tap  from any mailbox.  

  

The number of unread e-mails in each folder is shown next to the 

folder name. 

A gray triangle indicates that the folder contains subfolders. Click the 

triangle to expand or collapse the folder structure. 

 Domino folders 

On Lotus Domino systems, you can create folders and subfolders at 

the same time by naming a new folder like this: Work\Testing. When 

created in this way, the parent folder (Work) cannot itself contain 
emails (but Testing can). Therefore the parent folder (Work) is 

shown in a different color in DME, and it cannot be selected (but the 

subfolder Testing can). 

 

Tap a folder to open it in the mailbox view, or tap Cancel to go back 

to the mailbox you came from. 
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Tap the icon to open a window to set options for one particular 

folder. You cannot modify the settings of the five system folders.  

 
In the folder settings (see Folder settings on page 117) you can set 

defaults for the way email folders should be synchronized between 
collaboration system and the DME app. If you have many folders on 

the collaboration system, it is recommended that you set up very 

restrictive default settings to make things go faster, and then loosen 

up on individual folders as described below. 

 Use default values 

If selected, the current folder uses the general settings specified. If 

Apply to subfolders is also selected, the default settings will be 

applied to all subfolders below the current folder as well when 
you press Done. If this setting was not selected, and you select it, 

the settings in the remaining fields in this screen will be reset to 

the default values from the Folder settings when you press 

Done. 

If you want to apply other settings than the default settings to this 

folder, you must disable this field. 

 Sync. folder 

This option can only be changed if Use default values above is 

disabled. If you enable this option, emails in the current folder are 
synchronized with the collaboration system, using the 

synchronization window defined in the field Days back below. To 

avoid too high load on the DME server component, you should 
only synchronize those email folders that you really need on the 
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device. You can for example consider to not synchronize folders 

containing graphics-intensive newsletters etc. 

 Days back 

This option can only be changed if Use default values above is 
disabled. When emails are synchronized, emails from the last 

number of days selected here will be synchronized and available in 

the current folder. You can select up to 99 days, but we 

recommend that you choose a much smaller number. 

 Include in mail scan 

This option can only be changed if Use default values above is 

disabled. If you enable this option, you will receive a notification 

when a new email arrives in this folder. New email can "arrive in" 
subfolders by means of rules, which are set up on the 

collaboration system to automatically distribute new emails in 

folders. 

 Apply to subfolders 

If you enabled this option, the settings made in other fields in this 
screen are applied on folders below the current folder when you 

press Done. Use this function with caution, as the setting may 

affect many folders. Note that you can choose this option 

regardless of the value of the field Use default values above. 

 Add to Desktop 

If enabled, the folder is added to the DME Desktop. On the 

desktop it will get its own icon, that - when you tap it - will go 

directly to the folder. 

Tap Done when you have defined the settings for the current folder. 

Instead of synchronizing a large number of emails to the client, you 
can use the Search on server... function to find emails in any folder 

on the collaboration system. See Finding email on page 46 for more 

about this. 
 

Attachments 

Attachments, such as documents, spreadsheets or presentations, can 

be part of email messages, events, and notes. Attachments work in 
the same way, no matter where they came from, so we will simply 

discuss them from an email point of view. 

Please note that the DME Admin may have restricted access to 

receiving and sending attachments for security reasons. 
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In any mailbox, you can recognize emails with attachments by the clip 

icon next to the sender name: . 

When you open an email with attachments, the number of 

attachments is shown at the top right in the email:  

Tap the icon to see the names of the attachments. In order to save 

costs and time, DME does not download the attachments to the 

device until you need to see them. To download an attachment, 
simply tap it, or select Download all to make the DME app 

download all the attachments of that email to the device. This is useful 

if you want to be able to read the attachments while offline, for 

instance during air travel. 

The attachment is now stored in the secure container of your device, 

and you can view it and optionally edit it. 
 

Viewing attachments 

Tap a downloaded attachment to view it. 

DME Viewer/Editor 

DME contains a built-in document viewer and editor - the DME 
Viewer/Editor. We license the technology for this from ENTWRX 

SecureWrx (formerly known as Picsel Smart Office). 

 
If you have access to using DME Viewer/Editor (you must have a 

license, and it must be enabled for you in the DME server 

component), then the internal viewer on your device is disabled while 
you are working in the DME apps, and all supported files (including 

attachments) are opened in DME Viewer/Editor. There are several 

advantages of this: 

 Security: The attachments never leave the secure DME 
container, and you can be sure that the documents cannot be 

leaked outside the container, either by intent or by accident.  

 Usability: You can use the DME Viewer/Editor to create new 

documents or edit existing documents. 

If you have access to DME Viewer/Editor, you can securely view 

documents of the following types: 
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 Microsoft Office documents (Office 97, 2003, 2007, 2010, or 

2013) 

 Plain text files (.txt) 

 Adobe PDF (.pdf) 

 Bitmap images (.jpg, .bmp, .png, .gif) 

 Vector images (.wmf, .emf) 

 3D images (.jps) 

For more about the features available in DME Viewer/Editor, see 

DME Viewer/Editor on page 107. 

Internal viewer 

If you do not have access to DME Viewer/Editor, the attachment will 

be opened in an internal viewer, which is selected by the device you 

are using. The disadvantage of this is that the document is opened 
outside the secure DME container, and there is no guarantee that 

information from the document you are viewing will not be leaked to 

the device. This means that another person may be able to restore 
the document from left-over data on your device, even after you have 

closed the internal viewer. 
 

Editing attachments 

If you have access to DME Viewer/Editor, you can edit documents of 

the following types: 

 Microsoft Office documents (Office 97, 2003, 2007, 2010, or 

2013) 

 Adobe PDF (.pdf): Highlight text, annotate with freehand drawings, 

or add comments 

For more about this, see Creating and editing documents on page 

109. 
 

Adding attachments 

You can add attachments to emails and meeting invitations and 

notes/journals. 

 Adding attachments 

To add an attachment to an email you are writing (either a new one 

or one you are replying to or forwarding), 

1. Tap the  icon in the floating toolbar. 
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2. You can now choose what kind of attachment you want to add. 

 
If you have access to DME Viewer/Editor, you can create new MS 

Office documents to include as attachments. See Creating and 

editing documents on page 109. If you do not have access to 
DME Viewer/Editor, you can choose among Library, Camera, or 

Attachments. 

3. Tap Library to select a Photo Album, and tap to select the 

pictures or videos that you want to add. You can select several.  

or  

Tap Camera to attach a new photo/video. Note that if you attach 
images and videos directly using the Camera, they are not stored 

on the device, but saved into the new email as an attachment 

directly. This means you can't find it in your Library afterwards, 

but only in the Sent mailbox. 

When you have selected the attachment(s) you want to use, DME 

offers to change the size of the attachment before you add it:  
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By reducing the size of the image, you can save transmission time 

and costs. Also, you can get around a limitation that disallows 

uploads greater than 32 MB. Pick one: 

Small: The longest side of the image will be 320 pixels. For 

videos, this is Low quality. 

Medium: The longest side of the image will be 640 pixels. For 

videos, this is Normal quality. 

Large: The longest side of the image will be 1280 pixels. For 

videos, this is High quality. 

Original: The image will not be resized, and the video will not be 

re-sampled. 

Cancel: Do not add the attachment anyway. 

If the original image is smaller than either of the sizes above, then 

the size will not be shown among the options - for instance, if the 
image is 800 pixels on the longest side, the Large option will not 

be shown. 

4. Finally, you can tap Attachments to select from among the 

attachments that have been downloaded to your device (from 

existing e-mails). DME shows the list of existing attachments: 

 

Tap to add an attachment to your email. 

5. After adding attachments, you can tap an attachment to view it. If 
the attachment was selected from among existing attachments, it 

will be downloaded first if it wasn't already. Swipe left to remove 

it from the list. 

Note also that if you use DME AppBox, you can add files to emails 

through the DME File Browser. See File browser on page 98. 

6. Tap Back when you are done to go back to the email you are 

writing. 
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Managing attachments 

To manage all attachments on the device, open the Attachments 

view from the Desktop by tapping . 

 

This list shows all the attachments referenced by emails, events, etc. 
in your mailboxes. If the attachment type is known, the file type is 

shown by the icon on the left. If an attachment has been downloaded 

to the device, it is shown in black letters; otherwise it is shown in 

gray. 

If you remember part of the name of an attachment, you can quickly 

find it by typing in the Search box at the top of the list. The number 

of attachments shown in the list is reduced as you type. 

Tap a gray attachment to download and open it. You can cancel the 
download by tapping the X icon or Cancel at the top right. You can 

download all referenced attachments to your device at once by 

tapping Download all at the top right corner. 

If you want to remove all attachments from the device, tap Delete 

all attachments from the  menu in the Desktop. 

When you tap an attachment that has already been downloaded, you 

get a number of options: 
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 Open: Open the attachment using DME Viewer/Editor (if 

available) or the internal viewer. 

 Save: Save the attachment in the folder Attachments (saved) in 
the secure DME container. You get a chance to rename the 

attachment first: 

 
You can then later find and open, edit, copy, move or delete the 

attachment using the AppBox File Browser. This requires access 

to AppBox. See File browser on page 98. 

 Show email (or Show event or Show note): Opens the email, 

event or note through which the attachment was originally sent.  

You can also Sort and Filter your attachments. 

 Sort: Tap Sort to sort the attachments by name, size or date. 

 Filter by size: Move the slider to filter out the smallest 

attachments. Useful if many of your emails for instance contain 

small signature graphics. 
 

Calendar 

The calendar app lets you securely view and work with your business 

calendar. You can also choose to integrate external, personal 
calendars, for instance from Google or Facebook. Items from external 

calendar apps that are shown in the DME calendar app will not be 

synchronized to Outlook or Lotus Notes. You can see more about 

this in the section External calendars on page 71. 

From the calendar, you can create new events and appointments, and 

invite other people to meetings. Meeting invitations from other 

people are received in the DME Inbox, and are transferred to the 
calendar when you respond to them. You can respond to meetings by 

accepting, declining, delegating or proposing a new time for the 

meeting. 
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Events created in the DME calendar app on the device are saved 

directly in the calendar, and transferred to your Outlook or Lotus 
Notes calendar at the next synchronization. People that you invite for 

meetings are also notified at the next synchronization. 

 Calendar terminology 

In calendaring terminology, three terms are frequently used: 

Appointments, Meetings, and Events. The differences between these 

terms are the following: 

 Appointment: This is an activity that you schedule in your 
calendar, and that you do not invite other people to or reserve 

resources for. 

 Meeting: This is an appointment that you invite people to or 

reserve resources for. 

 Event: This is an activity that lasts 24 hours or longer - for 
example a trade show, a vacation, or a seminar. This can also be 

an annual event such as a birthday. Events do not occupy time in 

your calendar, but are shown as a banner along the top. 

We use event as the most general term for a calendar item, even if it 

does not last a whole day. 

 

You get calendar alerts on your device, even when DME is closed. 
 

Calendar views 

The Desktop calendar icon  shows today's date. Tap it to open 

the calendar app. 

You now see your business appointments (as in Outlook or Lotus 

Notes), and possibly private appointments from an external calendar 

app.  

If you hold your device in Portrait orientation, you see your 

appointments for today as a list, and you also you get an overview of 

the current month. Rotate your device to Landscape mode to see the 

week view. 

Tap the buttons along the top of the screen to switch views: 

 

 Month view: See an overview of your schedule for one month. 
This is the default view in portrait mode. Browse to the previous 
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or next month by swiping the month calendar or tapping the left 

or right arrows shown around the month name and year. Today's 
date is recessed and shown with a gray background. The week 

numbers are shown along the left-hand edge. Dates shown with 

boldface text contain appointments. Tap a date to show the 
appointments for that day. The currently selected day is shown with 

a blue background. Your appointments for the selected date are 

listed beneath the month view. 

If an event has an alarm, a small alarm icon  is displayed with 
the event. If other people have been invited to the meeting, a 

small participant icon is displayed with the meeting . 

If you have chosen to also show personal calendar events in DME, 

these events from other calendars in your device Calendar app are 
shown in the color defined for the personal calendar to which the 

event belongs. See Calendar settings on page 118 and Interaction 

with the device Calendar. 

Tap  to go to the Day view, or rotate to landscape mode to go 

to the Week view. 

 Day view: See all calendar entries for one day. Browse to the 

previous or next day by swiping, or by tapping the left or right 

arrows shown around the day name and date. The events are 

shown as Subject (Location). 

The events shown are color-coded according to their type: 

 Green: Personal appointment (no other participants). 

 Blue: Accepted meeting. 

 Red: Tentatively accepted meeting. 
 Gold: All-day event. 

 Gray: If you have chosen to also show personal calendar 

events in DME, these events from other calendars in your 
device Calendar app are shown in gray. See Calendar settings 

on page 118. 

Tap  to go to the Month view, or rotate to landscape mode to 

go to the Week view. 

 Week view: Rotate to landscape mode to go to the Week view. 
Here you see all calendar entries for one week. Browse to the 

previous or next week by swiping, or tapping the left or right 

arrows shown around the month name and year. The week number 

is shown to the far left, above the times. 

Rotate to portrait mode to return to the view that was shown 

before you showed the Week view. 
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 Event list view: Tap  to go to the Event list view. This view 

lists all your appointments in one screen. In this view, you can 

search for a particular event. See Searching for calendar items. 

A badge on the Appointment list button means that you have 

received one or more meeting invitations that you have not yet 

replied to. These meeting invitations are shown at the top of the 

appointment list: 

 

Tap an invitation to respond to it, or tap an appointment to view 

details or edit it. 

The calendar shows all the events from the beginning and till the end 

of your calendar synchronization window (the period within which DME 

synchronizes your calendar - see Calendar settings on page 118). 

Examples of the different calendar views are shown below (from 

iPhone 4S running iOS 6). 
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From each view, you can: 

 Create an event: Tap the  button to create a new meeting. 
The default date set for the new meeting is the currently viewed 

day. In the Week view, the date of the new meeting is set to the 
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date last viewed in one of the other views, or, if you entered the 

Week view directly, the default date is set to the first day within 
the viewed week. If that date has passed, today's date is suggested 

as the meeting date. See Creating events on page 65. 

 Go to Today: To go to today's date in any view, tap the Today 

button, or tap the month or date name (the view heading).  

 Synchronize calendar: Perform a manual calendar 

synchronization by tapping the  button. See Synchronization 

on page 29 for more about this. 
 

Viewing and editing events 

Tap an event in the calendar to open it. You can now see all the fields 

that have been completed for this appointment, but you cannot 

change any fields yet. 

 
To go back to the calendar view you came from, tap the top left 

button (the name of the view you came from). 

Tap the location marker  to open the meeting's location in the 

Maps app, if a location was entered as an address. 

Tap the Participants or Notes field to see the field's information in 

a separate view. From this view, any included links are active.  

Tap the New button  to create a new email to all participants in 

the meeting. This can be handy; for instance if you need to send a 
quick message to everyone in the meeting that you will be half an 

hour late. 
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Tap the top right Edit button to edit the event: 

 If you are a participant of the event, you can now set an alarm for 

the event, and you can change the event status to Private 
(meaning that details of the event will not be shown to others 

with access to your calendar). 

 If you are the chair (organizer) of the event, you can change all 

details of the event. If you remove a participant, the participant 
will receive an event cancelation notice, and the event will be 

removed from his/her calendar. If you change the time or date of 

the event, you are given an option to attach a comment about why 

you made the change. 

 Lotus Notes permits the use of formatted text and 

attachments in the meeting description (body). If the description 

contains attachments, you will not be able to edit the description 
here on the device. If there are no attachments, and you edit the 

Description field on the device, any formatting and any embedded 

objects in the field will be lost when the calendar event is 

synchronized back to the collaboration system. 

Tap Save when you are done. See Creating events on page 65 for 

more about creating events. 

For information about the options in the bottom toolbar or in the 

menu, see Responding to invitations on page 62. 
 

Responding to invitations 

When meetings are booked on the collaboration system, all invited 

participants receive a meeting invitation by email, containing 

information about the meeting. 

In the DME app, you can find your meeting invitations in two ways: In 
the Mail app's Inbox, where meeting invitations can be recognized by 

a meeting icon  - see Email on page 32 for more about the Inbox. 

On the Desktop, you can tell that you have new invitations if the 
Calendar icons shows a badge. Also, the calendar app's List view will 

list meeting invitations to which you have not yet responded (see 

Calendar views on page 57). 

A meeting invitation is actually an ordinary email, but with more 
options. The standard email options of Reply, Forward, etc. are 

described elsewhere - see Responding to email on page 45. This 

section describes those options that are specific to meeting 

invitations. 
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 Responding to a meeting invitation 

1. Open the meeting invitation. You see an overview of the event, 

with subject and time of the meeting, who organized it, who have 
been invited (participants), and any information about location and 

resources involved in the meeting. 

 
DME checks your calendar and immediately shows you if the 

invitation overlaps another meeting in your calendar. If it does, the 

message "Meeting conflicts with your existing schedule" is shown 
in red below the option buttons. Tap the Calendar icon in the 

invitation to open your calendar on the meeting date. 

Tap the location marker icon  to open the meeting location in 

Maps (only useful if an actual address is specified). 

2. You can now choose among the available options. Most of the 
options are available on all supported collaboration systems, but 

there may be differences. Those are noted below. 

DME observes the way in which your collaboration system works 

with events. For instance, in Domino the chair can select options 
in the meeting invitation in Notes specifying that he or she does 

not want to receive responses from invitees (participants), wants 

to prevent counter-proposals, or wants to prevent delegation. 
Such options are naturally observed by DME, even if they are not 

mentioned in the descriptions below. 

 Accept: Accept the meeting invitation. The meeting is created 

in the calendar, and a notification of your acceptance is sent to 
the meeting organizer/chair. 

 Tentative: If you want to attend the meeting, but you are not 

sure that you are available at the proposed time, you can 
tentatively accept the meeting. This way the meeting is booked 
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in your calendar, but the time still appears free for other users. 

Note: On Exchange 2003 systems, this action is not available 
for recurring meetings. 

 Decline: Decline the meeting invitation. Notification of this is 

sent to the organizer/chair and any other participants. The 
event is not entered into the calendar. If you just delete the 

invitation using the  button at the bottom, the 

organizer/chair will not be notified that you are not coming.  

The following options may be available when you tap the Reply 

 button in the toolbar: 

 Standard email reply options: See Responding to email 

on page 45. 

 Propose new time: If you would like to attend, but you are 
not available at the proposed time, you can propose a new 

time (also called countering the meeting proposal). Selecting this 

option opens a new screen in which you can select a new time, 

date, and time zone for the meeting. 

 

When you are done, select Send to suggest the new proposed 
time to the chair. When you send the new proposed time, the 

meeting chair/organizer will receive an e-mail with the subject 

Countered: and the subject of the meeting. 

Once the calendar entry has been accepted, you are not able 
to change the time zone of the calendar entry if you later edit 

the calendar entry from your calendar to propose a new time. 

Note: On Exchange 2003 systems, this action is not available 

for recurring meetings. 
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 Delegate: If you are unable to attend the meeting, you may 

want to send someone else in your stead. Choose Delegate, 
and select another user from your local or global address 

book. 

 
The Delegate field functions as other recipient fields - you 

can choose from the local and global address books and 

addresses from the Inbox. See Selecting recipients on page 

42 for more about this. 

When you are done, tap Send to send the delegation, or 

Check free time to see if the new proposal conflicts with the 

calendars of any of the delegees. For more about this, see 

Checking free time in Entering event details on page 66. 

3. When you accept, decline, tentatively accept, propose a new time, 

or delegate a meeting invitation, you are given the option to add a 

comment. If you enter a comment, it is sent to the organizer/chair. 
Note: On Exchange 2003 systems, not all actions allow you to 

reply with comments. 

4. When you respond to a meeting invitation by using any of the 

above actions, the email containing the invitation is removed from 
your Inbox, and if you accepted the meeting, your calendar is 

updated on the collaboration system at the next calendar 

synchronization. 

Along the bottom of the screen are more standard email options. See 

Email functions on page 40. 
 

Creating events 

Booking meetings or creating events on the device essentially works 

the same way as when using Outlook or Lotus Notes. 

 Creating a new event 

1. To create a new event, tap the  button from the Calendar. 

This opens the event creation form. 
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2. Enter the details of the event. You can specify an event title 

(subject), location, and a date and time; any participants and other 
resources that should be present at the event; an event 

description and any attachments. You can also specify if the event 

is to be repeated. For more about all this, see Entering event 

details on page 66. 

3. If you invited participants or other resources, you can check their 

schedule to see if they are free at the time you selected. This is 

also described in the section Entering event details on page 66. 

4. Tap Send (if you have invited participants) or Save (if it is a 

personal appointment) to create the event. 

The calendar app will prompt you to synchronize immediately. At the 

synchronization, meeting invitations are sent to any selected 

participants and resources. The event is shown in your calendar 

(whether you choose to synchronize or not). 

If you tap Cancel during the creation of an event, you can choose to 

Save as draft or Discard changes. Selecting Save as draft allows 

you to interrupt your work on the event proposal for a later time - 
the draft is stored in the Drafts folder. The Discard changes option 

closes the current meeting draft without keeping any of your edits. 
 

Entering event details 

In the event creation form, you can fill in a number of fields with 

details about the event. Each field is described below. 

Event information 

First you enter information about the event. 

 Subject: Enter the event title. 

 Location: Here you can enter free text describing the location of 

the event - for instance an office, a country or a city. If you add a 
complete address, the recipient will be able to tap the address and 

look it up in Maps. 

 Date and time: Tap the Start or End field, and spin the wheels 

to select the starting and ending date and time for the event.  

If you enable the field All day, the event changes to an all-day 

event, and you can only choose one date. 
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 Time zone: In this field you select the time zone of the location 

where the event is held. For instance, if you are based in 
Copenhagen, but want to call a meeting at 2 PM in London, you 

should enter 2 PM as the meeting start time, and Europe/London 

in this field. This way, the meeting will be placed correctly in your 
calendar - which is at 3 PM in local Copenhagen time. When you 

travel to London, and the phone changes time zone, it will be 

shown correctly in the calendar at 2 PM, London time. 

Use the search box at the top of the screen to search for your 

time zone. For instance, enter "Lon" to find Europe/London. 

 Repeats: Tap Repeats if you want to define a repeat schedule 

for the current event. This is  two-step process: 

1. First you choose to repeat the current event at the intervals 

listed in the Repeat screen (for instance Every Week), and 
tap Done. 

2. Then a new field is shown in the event creation form: End 

repeat. Here you set an end date for the repetition, or 
choose to let the repetition go on "forever". (If you choose 

"forever", the DME server component will actually stop the 

repetition after 5 years.) 

Recurring (repeating) events created on the device are sent to the 
server as a true series of recurring events, not as individual events. 

When you create recurring events, you will not be able to see the 

individual instances of the event on your device until you have 
synchronized your calendar. This is because the individual entries 

are actually created by the DME server component and then 

synced back to the client. 

However, recurring meetings created on the collaboration system 
are synchronized to the DME app as a series of individual 

appointments. This means that if you edit one in a series of 

meetings, only that instance of the meeting series will be changed. 
If you want to edit the entire series, you must do so in Microsoft 

Outlook or Lotus Notes. 
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 Alarm: This is not really part of the event creation - it is only 

used to set the alarm on your device and in Outlook/Notes to go 
off when the event is approaching. You cannot set the alarm for 

participants! Choose a time from among the options, and tap 

Done. 

 Private: Mark the meeting as private. This means the the meeting 
details are not visible to other people in the collaboration system 

when you sync the calendar item, but your time will appear 

booked. Note that this applies to your own calendar only - you 

cannot set the Private status for participants! 

 Notes: Enter more information about the new event, such as an 

agenda. This will be the body text of the calendar entry. 

 Attachments: Here you can select one or more attachments to 

include in the event invitation. See Adding attachments on page 

52. 

Resources and participants 

You can now choose to book resources, such as a meeting room or a 

portable projector, and pick participants for the event. 

 Rooms/Resources: The procedure for booking a room or a 

resource is identical - in the following, the booking of a room is 

described. 

The first time you open the Rooms page, it is quite empty. This is 

because you must download the available rooms and resources 

from the collaboration system to your device first. A message asks 

you if you want to do this now: 

 

1. Tap Download to download rooms and resources. You can 

always refresh the list by tapping the  button in the first 

Rooms or Resources screen. The list of rooms or resources 

is now retrieved from the collaboration system. 

This list may contain multiple sites, and you may need to 
choose a site before you can see the list of rooms or 

resources. If your organization uses only one site, the list of 

rooms or resources is shown directly. 
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2. Flick up and down in the list of rooms or resources, and tap to 

mark the rooms or resources you want to book. Note that if 
the people capacity of the room is entered in the collaboration 

system, it is also shown in the list. 

 
3. Tap Done. The selected rooms or resources are entered into 

the field in question, and you are returned to the event 

creation form. 

 Participants: To add participants to the meeting, do the 

following: 

1. Tap Required participants. 

2. In the To field, add or select participants as you would for an 

e-mail. See Selecting recipients on page 42 for more about 
this. 

3. Tap Save to return to the event creation form. 

Repeat this process for Optional participants and FYI 

participants. FYI participants (also known as CC recipients) only 
receive a notification that the meeting is held, they are not invited 

as such. 

Checking free time 

When you have added participants, rooms and resources, you can 

check if they are available within the time frame specified for the 

meeting. 

 Checking free time 

1. Tap Check free time in the toolbar. 

DME checks availability on the server. If all are available, a message 

at the top of the screen says so. 
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If one or more participant or resource is unavailable, the following 

option is shown: 

 
2. Tap Available times to find a free slot in the calendar of the 

participant(s). 

 
The gray areas are the combined busy times of all participants and 

resources; the gold color event called Appointment to schedule 

is the one you are trying to place in the calendar. 

3. Tap in a free place in the calendar to move the suggested time of 

the meeting. 

4. Tap Done to return to the meeting creation form. 

The meeting details are changed to reflect the update. 
 

Finding events 

To find an event or appointment in your calendar, open the List view 
in the calendar app. Just above the list of events, there is a search 

box: 
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You can use this box to search for calendar events. Type what you 

what to find, and tap the Search button on the virtual keyboard. The 
number of calendar entries now reduced to only show those that 

contain the text you entered. This text can be found anywhere in the 

event - the text can be names in the organizer field or the recipient 

fields, or text in the subject or body fields. 
 

External calendars 

The primary function of the DME calendar is to keep your business 

calendar synchronized with the calendar on your collaboration system 
(Outlook or Lotus Notes), and keep your business appointments 

stored securely in the DME secure container so that nobody else can 

gain access to them. 

 
DME keeps the data in the DME apps (calendar, contacts, etc.) in sync 

with the data on the collaboration system. 

Your Apple device also comes with a calendar application, aptly 
named Calendar. This calendar is used for personal appointments, and 

consists of a local source and possibly one or more third-party sources. 

The calendar can be configured to use third-party sources, such as 
Google Calendar or iCloud, in the device Settings. In your device 

Calendar app, you can choose which calendar or calendars you want 

to see, by tapping the Calendars button. 

Soliton Systems recommends keeping business appointments in the 
secure DME container, and personal appointments in the device 

Calendar. This is called Secure mode. 

However, if you want to be able to view your business appointments 

without having to log in to DME, you may choose to mix the 
calendars, so that events from the DME calendar can also be viewed 

in the device Calendar application - like this: 
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This is called Open mode, and can be selected through an option 

called Copy to local in DME. In this mode, calendar events from 
DME are copied to (not synchronized with) a new calendar in the local 

source of the Calendar app. In the example above, the user is 

synchronizing personal appointments from his Google Calendar with 
the device Calendar (as a third-party source). By copying DME events 

to the local source we make sure that data from DME is not mixed 

into the user's Google calendar (which may also be shared with 

others). 

Note: For this to work correctly with third-party synchronization 

services other than iCloud, you must ensure that a local calendar 

source exists before you enable the third-party sync. If it does not 
exist already, the third-party service will take over the entire 

calendar, and DME will be unable to create a local calendar. You can 

prevent this from happening in one of the following ways: 

1. Make sure the DME calendar mode is Open (Copy to local is 

On) before you enable third-party sync. 

or 

2. Manually create a calendar appointment in the device calendar 

before enabling third-party sync. 

Note: This does not apply if you synchronize with iCloud. If you do that, 

be sure to see Synchronizing calendar with iCloud on page 73. 

In Open mode, there are some considerations: 

 DME-related events and appointments must be created, deleted 
and updated from DME. Any modifications in the local DME 

calendar in the device Calendar app will not be synchronized back 

to DME. It is one way only - from the secure DME calendar to the 

device calendar, meaning that: 

 DME creates the entries in the local DME calendar in the 

device Calendar app. 

 DME updates the entries in the device calendar when they are 
changed in DME. 

 DME deletes the entries in the device calendar when the 

synchronization window changes or when they are otherwise 

removed in DME. 
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 If you decide to change to Secure mode, any events in the local 

DME calendar in the device Calendar app are removed. In fact, the 
entire local DME calendar is removed. Everything is of course still 

securely stored in the DME calendar. 

 If you are synchronizing your device calendar with iCloud , the Apple 

iOS hides all local calendars in the device calendar, for as yet 
undisclosed reasons. Again, be sure to see Synchronizing 

calendar with iCloud on page 73. 

Using another option in DME, called Show in DME, you can tell the 

secure DME calendar to show all entries from the device Calendar in 
DME. The entries are shown with the colors selected for the entries 

in the device Calendar app as shown below.  

 
For information about how to switch calendar modes and set the 

Show in DME option, see Calendar settings on page 118. 
 

Synchronizing calendar with iCloud 

Special rules apply when you are synchronizing with iCloud. iCloud 

synchronization does not follow the same rules as other third-party 

synchronization services do, and the following steps are required if 

you want to run the Calendar in Open mode (Copy to local). 

 iCloud: Setting up DME Open mode with iCloud 

1. Make sure that the DME calendar runs in Secure mode (Copy to 

local is Off). 

2. Enable iCloud calendar sync in your device Settings. 

3. Manually create a calendar, and call it DME. 

4. Set the DME calendar mode to Open (Copy to local is On). 
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If you do not perform these steps, you risk having what seems to be 

duplicate calendar entries in your device calendar (and your DME 

calendar, if Show in DME is enabled). 

The reason for this is that when iCloud is enabled, it completely takes 

over any existing local calendar source. This can be illustrated as 

follows. 

The calendar with DME in Open mode, and before iCloud is enabled: 

 

What happens when iCloud is enabled: 

 
So the trick is to manually create a calendar in iCloud called DME. 

With iCloud enabled, the device calendar will only show entries from 

calendars that are controlled by iCloud. However, when you manually 
create a DME calendar in iCloud, iCloud allows the entries stored in 

the similarly named local calendar source by DME to be shown in the 

device calendar also. 

If you are already experiencing duplicate calendar entries in your DME 

calendar in Open mode, you can do the following to fix it: 

 iCloud: Fixing duplicate iCloud calendar entries 

1. In iCloud, delete any DME calendar. One or more prompts will 

warn you that you may lose calendar entries, but confirm the 

deletion anyway - you will only lose the duplicate entries. 

2. In DME, set the DME calendar mode to Secure (Copy to local is 

Off). 

3. Manually create a calendar called DME in your iCloud-enabled 

device calendar. 

4. Set the DME calendar mode to Open (Copy to local is On). 

Your duplicate entries will be gone. 

If you have set up iCloud and DME correctly, and you temporarily 

disable the iCloud sync, you should do the following. 

 iCloud: Disabling and re-enabling iCloud 

1. In DME, set the DME calendar mode to Secure (Copy to local is 

Off). 
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2. Re-enable iCloud. 

3. Set the DME calendar mode to Open (Copy to local is On). 

Since you have already once created the DME calendar manually, 

iCloud will not take over the DME calendar created by DME when 

you enable Open mode, and things are working again. 
 

Contacts 

You can have your personal contacts from Outlook or Notes 
synchronized to your device. The contacts are entered in the DME 

Contacts app, enabling you to use your familiar contacts for emails, 

meetings, and possibly phone calls etc. 

Contact synchronization is enabled in Settings (see Contacts 
settings on page 120 for more about this). When enabled, any 

changes you make in your contacts in Outlook/Notes are 

synchronized to the DME Contacts app, and vice versa. 

In DME Settings, you can furthermore choose to also synchronize 
your contacts with the Contacts app on your device - from now on, 

these are called your local contacts. You can do this by enabling 

synchronization with local contacts in Contacts sync. settings. If you 
do, your DME contacts are copied to a new contacts group named 

DME in the device Contacts app, and are then kept synchronized with 

DME. This means that if you add, delete, or modify a contact in your 
device Contacts, the change will be synchronized to DME, and 

ultimately to the collaboration system (and vice versa). 

You can see more technical details about this in Third-party 

contacts on page 80. 
 

Using contacts 

To view your DME contacts, tap  on the Desktop. The contacts 

are shown in the style determined by the settings Sort Order and 

Display Order in the iOS Settings > Mail, Contacts, Calendar, 
where you can for instance choose to sort your contacts by Last 

name and then First name, but view them with First name first or 

Last name first. 

Find a contact by tapping a letter along the right-hand side of the 

screen, or by typing in the Search box above the Contacts list. 
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The number of contacts shrinks to match what you type. DME not 

only searches the name; all information in the contacts is searched. 
That is why Jørgen Reith shows up in the search below - because his 

email address contains all. Tap a contact to open it. 

  

 

If the contact has a picture in Exchange or in Lotus Notes, you can 

tap the picture, and DME will add the picture to the contact (note 

that this feature requires DME Server version 4.4 or later): 
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To reduce the cost of traffic and storage on your device, DME will 

not automatically download the pictures.  

Please note that DME will not get pictures from your local contacts 

on the device, nor is it possible to upload pictures through DME. 

 

You can now tap any of the fields to use the information in the field: 

 Tapping a Phone field lets you create an SMS or MMS message to 

the contact, or place a call to the contact. If set up by your 

company, you might also have the option of making a call through 

a VoIP app. 

 

 Tapping an E-mail field lets you create an e-mail for the contact, or 

book a meeting with the contact. 
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 Tapping a Website field opens the link in the AppBox secure 

browser (if enabled), or in the internal web viewer. 

 Tapping an Address field opens the address location in Google 

Maps. 

 

Finally, you can tap the Export button to attach the contact 
information to a new e-mail. The contact will be attached as a vCard, 

and the name used as subject in a new e-mail. 
 

Working with contacts 

Different contact applications on different phones and phone 
platforms support different contact fields. A contact field is for 

instance the First name field or the Telephone field in a contact. 

When synchronizing the address book in MS Outlook or Lotus Notes 
to a mobile device, different third-party applications may map the 

fields in Outlook/Lotus Notes to the phone in different ways. 

The DME Address Book supports a large, but fixed number of fields. 

By using DME for synchronizing contacts, you can be certain that 
everybody in the organization maps contacts from the collaboration 

system to their device in the same way. 

When you tap  in DME Contacts, or when you tap Edit when 

viewing a contact, DME lets you enter information into the following 
fields. Those marked with * are shown by default. To see field which 

is not shown by default, tap Add field first to add it. 
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Name: 

Prefix 

First* 

First name (phonetic) 2) 

Middle 

Last* 

Last name (phonetic) 2) 

Suffix 

Nickname 

Title 

Department 

Company* 

Company (phonetic) 2) 

Phone: 

work* 

home 

other 

work mobile 

other mobile 

work fax 

home fax 

other fax 

assistant 

company 

pager 

E-mail: 

work* 

home 

other 

URL: 

work* 

home 

other 

Address: 

work* 

home 

other 

Street* 1) 

Zip* 1) 

City* 1) 

State* 1) 

Country* 1) 

 

1) For each address type. 

2) Japanese Furigana. 

Dates: 

birthday 

anniversary 

Other names: 

spouse 

children 

assistant 

manager 

Notes: 

note 

location 

categories 

IM 1-3 

Note: Due to a restriction in Lotus Notes, "Last name 
(phonetic)" is the only of the three Furigana fields that work. The 

other will be deleted when synchronizing.  

In Exchange, all three fields work. 

 

Searching for contacts 

As mentioned in Using contacts on page 75, you can find a contact 

by tapping a letter along the right-hand side of the screen, or by 

typing in the Search box above the Contacts list. 

 

The number of contacts shrinks to match what you type. 

You can also search in the Global Address Book (GAB). This is similar 
to what is described in Selecting recipients on page 42 about GAB 

search. 
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If you enter something in the Search box, but your DME Contacts 

do not contain what you searched for, you can tap Global Address 
Book to continue the search through the DME server component. 

The letters you entered in the Search box are transferred to the 

Name search field, and the search is executed immediately: 

 
You can tap another search field to apply the search criteria to that 

field immediately - for instance the Email field. 

And you can of course change the search criteria in the Search box 

and then tap Search in the virtual keyboard. 

Tap the contact you have found. You now have the same options for 

this contact as previously described in Using contacts on page 75. 

Apart from those options, you can tap Copy to local address 
book. This copies the contact to your DME contacts. Then you don't 

have to find the contact through a GAB search anymore. 
 

Third-party contacts 

The Contacts app can be configured to use third-party sources, such 
as Google GMail or Facebook, in the device Settings. If you do this, 

your device Contacts will contain both the DME group of contacts 

and the third-party source. The different groups of contacts will 
coexist in the device Contacts app, and there is no interaction 

between them - your DME contacts won't suddenly show up on 

Facebook. 

  

Note: For this to work correctly with third-party synchronization 

services other than iCloud, you must ensure that a local contacts 
source exists before you enable the third-party sync. If it does not 

exist already, the third-party service will take over the entire contacts 

store, and DME will be unable to create a local contacts group. You 

can prevent this from happening in one of the following ways: 
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1. Make sure that Settings > Contacts > Device Address Book 

is set to something other than Don't use, and that Contacts 

sync. is enabled, before you enable third-party synchronization. 

2. Make sure you have at least one contact in your DME contacts (the 

"local source") - even if you have to create one manually. 

3. When you do enable third-party sync, make sure you select the 

option to Keep on my device for the contacts found in the local 

source (you are asked twice). 

Note also that if you choose to synchronize contacts with iCloud, the 

Apple iOS will remove any local contact groups on the device, 

including the DME group of contacts. 

 
 

To-dos 

To-do lists are lists of things you need to remember to do. To-dos 

are like calendar events, because they have a start date, and end date, 

and an alarm. 

 To-do synchronization rules 

For a to-do to be included in the synchronization from the 

collaboration system to the device, the following criteria must be 

fulfilled by the to-do on the collaboration system: 

1. A due date has not been specified, and it has not been marked as 

complete (Domino only). 

2. No start date or end date is specified, and the task is not marked 

as complete. 

3. Or the to-do is overdue and not marked as complete, regardless 

of the values in the starting date and due date fields. 

4. Regardless of the above, a to-do is included if either the starting 

date or the due date is within the time span set in To-do settings 

(the sync window). 

Examples: 

The sync window is set to 10 days in To-do settings, and today is 

April 15th.  

1. A to-do on the collaboration system was created on March 23rd 

with a due date on April 17th. This to-do is synchronized to the 

device because the due date is within the 10-day sync window 

specified in the To-do settings. 

2. Another to-do was created on March 3rd, with a due date of 

March 16th. It has not been marked as completed. This to-do is 
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synchronized to the device. When it is marked as completed, it 

will no longer appear on the device. 

 

To view your to-do list, tap the  icon on the Desktop. There are 

three lists: a list of all to-dos with high priority, a list of not-yet complete 
to-dos, and a list of all to-dos. Use the buttons along the bottom of 

the screen to switch between the three lists. 

Update the list of to-dos by tapping the  icon at the bottom left. 

To delete a to-do, swipe it left and tap Delete. 

Tap a to-do to open it. You can now see the full subject text, any 

associated notes, information about dates and various other info. 
 

Creating and editing to-dos 

 Creating a to-do 

1. Tap  from the Desktop to open the To-do list view. 

2. Tap a to-do to edit it, or tap  to create a new to-do. 

 
You can now set a start date, a due date (end date), an alarm, and 

a priority for the to-do, and you can indicate that the to-do is 

Private (meaning that other people opening your calendar in the 
collaboration system cannot see the to-do in question). These 

features are similar to the corresponding calendar item features.  

3. Set the Completed status. In the To-do list view, you can choose 

to only view incomplete to-dos. 

4. Tap Save to save the to-do in the To-do list. 
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Feeds 

The DME Admin can define RSS channels which can be read by the 

DME app. An RSS channel (or feed) is a stream of links to articles or 

other content from a website that is frequently updated, such as a 
news site. Another source of an RSS feed could be a sales tools 

database (a list of new orders or other information from the sales 

database) or many other things. 

The advantage of using DME's RSS feed reader over any other feed 
reader is that the content of the feeds, which may be sensitive if the 

feed source is an internal database, is kept within the secure storage 

container of the DME app. 

To view the feeds that have been set up for you, tap  on the 

Desktop. A screen such as the following is shown: 

 

Each feed to which you subscribe is listed. The number to the right of 
each feed shows the number of unread articles in the feed. You or the 

administrator can limit the number of articles available on the device 

at any one time (see Feeds settings on page 123). A standard feed 
called Welcome to DME RSS Feeds is usually included in the list; 

this feed tells you more about the DME RSS Feeds functionality.  

The feeds are updated at regular intervals. The server takes care of 

sending a notification to DME when this happens. To update the feeds 

manually, you can tap the  icon. 

To view the list of articles in a feed, tap the feed title:  

 

Unread articles are shown in black letters; read articles in gray. To 

mark all articles as read, tap the  icon. 



DME App User Guide 

Getting work done: Email, calendar, and more 
 

84  © 2017 Soliton Systems 

 

Tap an article to read it: 

 
Most articles are just an excerpt of a larger article, and include a link 

to the full article. To view the full article in a browser, tap  in the 

toolbar.  

 
Then tap Open Web address. The article opens in the secure 

AppBox browser if enabled; otherwise in Safari. 

After reading, tap Back to return to the article in DME Feeds. 
 

Notes 

 
If you are using Lotus Domino as your collaboration system, you can 

synchronize notes (formerly called "journals") with your DME app. 

This requires that Notes synchronization is enabled in Settings (see 

Notes settings on page 122). 

Tap  on the Desktop to open the All notes screen.  
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In this screen, you can see all notes that have been synchronized from 

Lotus Notes to the device or created on the device, in all categories. 

You can sort the notes by Subject or by Date. 

To view notes of a specific category only, tap the  icon. 

 

Tap a category, and tap Done. The list is now filtered to show notes 

of that category only. 

Tap a note to edit it, or tap  to create a new note. While creating 

the note, you can choose any category for the note, or you can create 

a new category. You can set a date, and you can add attachments 
from the device to the note. For information about working with 

attachments, see Attachments on page 50 and Adding attachments 

on page 52. 

Tap  to synchronize your notes manually with Lotus Domino. 
 

Tools 

From the Desktop, you can access the Tools menu. This menu 

contains a number of useful functions, some of which have been 

described already. 

 Settings 

Customize your DME app. See Getting set up: Settings on page 

114 for more about this. 

 Reset 

This Reset function corresponds to an initial synchronization. 

There will usually not be any reason to do this, but if you think 

that any of the resources on your device are out of sync, you can 
reset the DME data on your device by choosing this function. This 

will perform an import of all resources. Before the reset is carried 

out, a warning is shown, listing all the data that will be replaced by 

a copy from the server. 

Accept this warning to continue. 

Note that the DME administrator can also force an import of 

items on your device. In this case, you will not be asked if you 
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want to keep the original entries; the device will simply start 

effecting the command and replace data from server. 

 Change password 

With this function, you can change your network password from 
the DME app. See Changing mailbox passwords on page 91 for 

more about what happens when your mailbox password is 

changed. 

 Unlock 

This function lets you choose your preferred way of logging in to 

the DME app. 

 

Possible options are: 

 Password. Use your regular Username and Password to log in. 
 Unlock Pattern. Selecting this will allow you to create an unlock 

pattern (swipe code) that you can use to log in. See Setting 

unlock pattern on page 87 for more. 
 Touch ID. Use the fingerprint reader on your device to log in. 

Requires that the fingerprint is already set up on the iOS 

device, see Setting up Touch ID on iOS 

https://support.apple.com/en-us/HT201371. 

Only the options you are allowed to use are shown. 

 Set unlock pattern 

If you are only allowed to use Password and Unlock Pattern, or if 

your device doesn't have a fingerprint reader, you will see Set 

unlock pattern instead of Unlock described above. See Setting 

unlock pattern on page 87 for more. 

 Log 

Displays the event log, which is kept by the DME app. The log can 

be useful in connection with support questions. See Getting help: 

Help desk and support on page 124. 

 Delete all attachments 

If you choose this function, you can delete all attachments from 
emails and meetings that have been downloaded to the device. 

They are not deleted from the collaboration system, only the 

device. 

https://support.apple.com/en-us/HT201371
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 Remove client cert. 

If Client signing is enabled on the DME server, you can only 

establish a connection with the server if your device is known and 
trusted by the server. This is achieved through a system of 

certificates. If a new certificate is generated for the device, you 

will need to delete the existing certificate on your device. If you 
can see this function on your device, a client certificate is in force 

on your device, and you can delete it by selecting the function. 

You should only do this if you are asked to do so by a DME 
Administrator, as you will not be able to log on again until the 

DME Administrator initiates the creation of a new certificate.  

 Lock 

Select this function to log out of DME. 

 Out of office 

This function lets you enable, disable, or change your out of office 

message. See Out of office on page 89. 

 MDM Enrollment 

This function is used in connection with Apple Enrollment if you 
are not using MobiControl. For more on this, see Enrollment 

with DME on page 11. 

 About DME 

View version information about the DME app. You can use this 

information in connection with with support questions. See 

Getting help: Help desk and support on page 124. 
 

Setting unlock pattern 

For reasons of security, you may be required to enter a long, complex 

password with a mix of letters and special symbols to gain access to 
the network and collaboration system. This may be easy enough to 

enter on a full PC keyboard, but you might find it difficult to enter 

using your phone keypad. 

Instead of using your collaboration system password for logging in, it 
is possible to use an unlock pattern instead. You enter  an unlock 

pattern by moving your finger across a number of tiles on the screen 

in a certain pattern. 

 Unlock pattern details 

In order to maintain high security on the device, the DME 

administrator can set up certain requirements of the pattern you 

enter: 

 The code defined by you may expire after some time. The validity 

period of the code is set by the DME administrator, and could for 
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instance be 8 hours, corresponding to one working day. The 

validity period begins when you log in to DME using your regular 
password. After this, you can swipe the pattern to log in to DME, 

until the validity period runs out. Then you have to use your 

regular password again in order to reset the validity period. You 

do not have to change the unlock pattern. 

The administrator may choose to allow an unlock pattern that 

never expires, but this is not recommended. 

 If you attempt to log in using the unlock pattern, but you enter the 

pattern wrong twice, then you have to use your regular password 
for your next attempt. Your unlock pattern is not invalidated, 

however - you can use it the next time you log in to DME. 

Note that the feature may be disabled entirely by the DME 

administrator for security reasons. 

Note on security 
Using a regular password offers the best protection of your data. If 

you use the regular password method for logging in, the network 

password is only kept in memory, and not stored when DME shuts 
down. Using the unlock pattern feature, your encrypted password 

will remain in the device storage, even when DME is shut down. As 

the key protecting the encryption of the password can be derived 
from a relatively small number of combinations when using the 

unlock pattern feature, the security level must be regarded as 

medium when enabling the unlock pattern feature. 

 

 Using an unlock pattern instead of a password 

1. Log in to the DME app using your regular collaboration system 

password. 

2. Select Tools > Set unlock pattern. 

If you cannot find this option, it is because the DME administrator 

has disabled it. 
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3. The following screen consisting of 12 circular tiles is shown: 

 
4. Move your finger vertically, horizontally and diagonally across any 

of the 12 tiles in the screen. For the pattern to become a valid 

unlock pattern, you must cover at least the number of tiles that 

are defined as the minimum by the DME administrator. 

Note that it is possible to swipe back across tiles you have already 

"used". 

5. Repeat the pattern to confirm the new unlock pattern. 

If you accidentally move your finger across tiles that you did not 

intend to touch, you can undo the current pattern by continuing 
to move your finger outside the pattern area. You can then try 

again. 

The unlock pattern definition screen closes, and your new unlock 

pattern is set. 
 

Out of office 

You can create, edit, enable, and disable your Out-of-Office (OOF: 

Out-of-Office Functionality) message directly from your DME app. 

After changing the OOF setting and synchronizing, the information 

added here will update the OOF rule in the collaboration system. This 
way, you can for instance enable your OOF message from your 

phone, if you forgot to do so during the last hectic hours at the office 

before your vacation. 
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 OOF considerations 

Depending on your back-end collaboration system, there may be 

some restrictions to your use of OOF from the DME app. 

 
OOF from the app only works on Domino if: 

 OOF must be running as an agent in Notes. 

 The DME connector providing OOF must be set up as a Notes 

Session connector. 

This falls within the domain of the DME administrator. Therefore, 

contact your DME admin if things do not seem to work. 

 
There are a few things you should be aware of in the way the OOF 

information is handled by different versions of Exchange: 

Exchange 2003: Exchange 2003 does not support start and end days 

for OOF rules, and the dates will be ignored by Exchange 2003. 

Exchange 2007/2010: DME does not support different reply 

messages for internal and external recipients. The text from the 

Description field will be used for both types of recipients. 

 

To configure your OOF rule, select Tools > Out of office. DME 
connects to the server to read the current OOF settings from the 

collaboration system. 
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 Enabled 

Select this field to enable the Out-of-Office rule; de-select the 

field to disable the rule. 

 Start 

In this field you can choose a date and time at which the OOF rule 

should become active, if enabled. 

 End 

In this field you can choose a date and time at which the OOF rule 

should become inactive again. 

 Description 

In this field you can enter or edit the text which will be used in 

the automatic response to people who write to you while the 

OOF rule is enabled. 

When you are done, select Update to synchronize the rule with the 

collaboration system. 
 

Changing mailbox passwords 

Depending on your company's security policy, you must change your 
network password at regular intervals. If you use Exchange, your 

network password is the same as your mailbox password, but on 

Domino collaboration systems this is not necessarily so - here you 
use your internet password. The DME app depends on the mailbox 

password to gain access to synchronize your email to the device.  

If your collaboration system is based on Active Directory, a message 

may pop up telling you well in advance that it is time to change your 
password. If you ignore the warning, your current password will 

eventually become invalid, and you will be unable to log on to the 

system. 

Changing and synchronizing passwords is a complex affair, and hard to 

describe in simple terms - but here goes: 

You can either change your password from a desktop computer on 

the network or from the DME app. 
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 If your mailbox password is changed from a desktop computer on the 

network, and you have exited DME (for instance in connection with 
a phone reboot) so that your credentials are no longer encrypted 

in memory, then the new password has to be verified by the 

server component the first time you log in to the DME app. When 
you log in, DME recognizes you as a user and recognizes your 

password, but detects that the password has been changed on the 

server. So the following message is shown: 

 

You are then asked to enter your new password. 

1. Select Verify to verify the new password on the server. 

2. Enter your old password. 

3. Select Done, or 

Select I forgot my password if you want to remove all DME 

data from the device and start over. 

You can now use DME as usual. 

 If your mailbox password is changed from a desktop computer on the 

network, and your device still has your credentials encrypted in 
memory: If you are logged in, DME will log you out the first time 

the device communicates with the DME server component (for 

instance in connection with a network push). When you log in 
again, you should use your new password. DME will assume that you 

have changed password on the server, verify your new password, 

and re-encrypt your credentials without you having to confirm any 

messages. 

 You can change your mailbox password from the DME app.  

1. Log in to DME as usual. 

2. Select Tools > Change password. 

3. Enter your existing password in the Old password field. 
4. Enter a new password in the New password field, and retype 

it in the Confirm new password field. 
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5. Select Change. 

 
DME sends the password change request to the server 

component. If the server accepts the request, a message tells you 

that your password has been changed. If the server rejects the 
request, a message tells you why the command failed. If the 

command fails, it can be an issue with the server setup, and you 

should contact your DME Administrator. 
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Getting together: AppBox 

and integration 
DME is not only about secure email, calendar and other data from the 

collaboration system. With DME, your company can provide you with 
secure access to internal HTML5 apps, internal websites, and internal 

files. This is called the DME AppBox. 

With DME, you can also read, edit, and create documents in the 

common Microsoft Office formats. This functionality is provided 

through DME Viewer/Editor. 

Both the AppBox and DME Viewer/Editor require separate licenses. 

The following sections assume that you have a license for both.  

First we describe the AppBox and the core AppBox apps that DME 

provides - the Launchpad and the File Browser. 

Then we describe DME Viewer/Editor. 

And finally we describe the integration between the DME app, the File 

Browser, and DME Viewer/Editor. 
 

DME AppBox 

DME AppBox was introduced in the DME client 4.0 for Apple iOS. 

DME AppBox is a secure corporate App Store. With DME AppBox, 
your company can push applications built with HTML5 technology and 

regular websites to the DME client. You can then open these apps and 

websites securely, knowing that no data can be leaked outside the 
safe DME area on the device. This area is referred to as the secure 

container. 
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When you tap the AppBox icon, DME will connect to the AppBox 

server. 

 
When a connection has been established, DME shows the AppBox 

Launchpad. DME comes with a standard Launchpad, but it may be 
customized or completely replaced according to your company's 

needs and design wishes. Therefore the screenshots in this section 

will probably not match what you see on your own screen. 

Furthermore, not everybody in the company gets the same AppBox 
Launchpad. The apps can be configured in many ways. For instance, an 

app can be configured to be shown on tablets only, or it can be 

configured to only be shown to a certain group of users. 

The default AppBox Launchpad might look something like this (in 

landscape orientation): 

 

Apps that are designed for offline use are shown first. Online apps are 
first shown as disabled (gray) and then enabled as they become 

available. If there are more apps than can be shown on one page, you 

can swipe to go to the next page of apps. The number of app pages is 

indicated by a number of dots along the bottom of the page. 

Tap an icon to launch an app. 
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All AppBox apps run within the DME secure browser. See the next 

section. 
 

Secure browser 

All DME AppBox apps are launched with the DME secure browser, 

which ensures that no data is able to leak from the browser to the 
client device. Any cookies, cache files etc. are stored and encrypted 

within the secure DME container. 

The secure browser contains no controls (buttons) at all. If the app 

simply shows an ordinary web page, there would be no Back, 
Forward, and Refresh buttons available to the user, and the user 

would be unable to exit the browser and go back to the AppBox 

Launchpad. To provide navigation, the AppBox administrator applies a 
skin to the app. The skin is configurable by the administrator, so 

different buttons can be shown in different apps. 

1. The "browser skin" provides standard browser navigation buttons 

and more: 

 
1. Back to AppBox Launchpad. 

2. App Home button - go to the location within the app that is 
shown when you first open it. 

3. Back (browser Back button). 

4. Forward (browser Forward button). 
5. Make this app a Favorite. See Favorites on page 106. 

6. Progress bar - active while loading a page. This space can also 

be used to show status messages. 

7. Refresh (refresh current page) or Stop loading page. 

This skin is typically used for intranet sites or other websites that 

have not been made specially for use in DME AppBox. 
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2. The "app full-screen skin" provides a semi-transparent slide-out 

menu on the left side of the screen. This is typically used for 
specially designed HTML5 apps and not regular websites. It slides 

out when you tap the three gray vertical dots: 

 

This menu may contain one or more of the following functions: 

1. A spinner is shown during communication with the website or 

connecting with an app. A moving download icon (an arrow) is 

shown when the app is being upgraded. Otherwise it is empty. 
2. Make this app a Favorite. See Favorites on page 106. 

3. Back (browser Back button). 

4. App Home button - go to the location within the app that is 
shown when you open it. 

5. Back to AppBox Launchpad (the diamond icon). 

If the app is designed for DME AppBox, the developer will typically 

place buttons in the top or bottom toolbars to provide the user 
navigation with options to go back to the Launchpad and perform 

other functions, as in the example below: 

 
As described in Links, the secure browser is also used for opening 

regular web links in emails. 
 

Keep documents for offline use 

Sometimes, for example when you read a PDF file online using the 
secure DME browser, you will want to store it for offline use - or just 

to be able to find it quickly again. 

Whenever you open a PDF or other file from the secure browser, 

DME will display an Offline button. Depending on how the AppBox 
menu item has been configured, this button can either appear as an 

arrow pointing down at the bottom of the slide-out menu: 
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-or as an overlay button in the lower left corner of the page: 

 
Note that the button is not shown until the entire document has been 

loaded. For large files, this may take a while. 

When you tap the Offline button, you are given the opportunity to 

rename the file. Then tap Save to save the file in the filestore of the 
current app. It can later be found using the DME File Browser. See the 

next section for more information. 
 

File browser 

The DME File Browser app is packaged with DME AppBox. With the 

DME File Browser, you can  

1. Manage all files that are stored in the DME secure 

container by other AppBox apps. 

For example, if you have an AppBox app that gives you access to 
your corporate customer relationship management system, you 

may want to download a contract or a purchase order from a 

certain customer before visiting the customer. The CRM system 
lets you download the requested information as a PDF file to the 

secure DME container, using the Offline button described in the 

previous section. 

To view the PDF file again at a later time, open the DME File 
Browser, and open the CRM system's file store, where the PDF 

file has been saved. 

2. Exchange files with file servers on the internal network. 

Through the File Browser, you get secure access to internal file 

servers. Depending on your permissions on the file server, you 
can view files on the file server, copy them to the Documents 

folder on your device, move and delete files, and create and delete 

folders. 

3. Create files using DME Viewer/Editor. 

Using DME Viewer/Editor, you can create MS Office documents in 

local folders. 

4. Send documents as attachments. 

From a local folder in File Browser, you can choose to send one 

or more documents as attachments to a new email. 
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Overview 

Open the File Browser to work with files on your device and 

optionally on your file server. 

On tablets, the DME File Browser is divided into two panes: 

Locations and Files. Both panes are visible in Landscape mode; in 

Portrait mode, you must tap Locations to slide out the Locations 

pane.  

On regular devices, only one pane is visible at a time. Tap the 

Locations button to switch between the views. 

 
1. The Home button closes the File Browser and shows the AppBox 

Launchpad again. 

2. The Locations pane shows system folders on the device (Device 

Locations) and optionally file shares on file servers (Remote 

Locations). 

3. Device Locations contains three system folders: 

1. The Recent files location shows a list of the files you have 

worked with most recently - up to 25 files. The files are listed 

with the latest first. 
2. The Documents location is your personal, secure folder on 

the device. Files copied to this location are available offline.  

3. The Applications location contains a list of all apps in your 
AppBox. Tap an app to view the files downloaded using that 

app. One of the folders in this location is called Attachments 

(saved) - this folder contains files that you save from an email 
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or the Attachments view in the DME app. For more 

information, see Applications location on page 100. 

4. Remote Locations contains a list of the file shares set up by the 
DME Administrator. The file shares usually point to folders on the 

internal, local area network - an area that could not easily be 

accessed securely without AppBox. You can copy files between 
the device and the remote locations. The remote locations cannot 

be shown when you are offline. 

A special file share can be defined to give you personal access to 

your own home folder, without anybody else being able to see it. 
Permissions are granted by the administrator during setup of the 

file share (which is based on the WebDAV protocol). 

5. The file list shows folders and files. For folders, a badge shows the 

number of files it contains. Files are shown with an icon according 
to the file type, the name of the file, the date and time of 

download, and the file size. Tap a file to view and optionally edit it. 

See Opening a file. 

6. Tap the Edit button (or tap-and-hold a file (long-press) for a 
second or so) to perform operations on one or more files. See 

File operations on page 103. 

7. Tap the Refresh button to refresh the file list. 

8. Tap the + button to add a file or a folder. See Adding files and 

folders on page 101. 
 

Applications location 

The Applications view shows a list of all DME AppBox apps that you 

have access to - all the apps in your AppBox Launchpad. The column 

on the right shows the number of files that have been downloaded by 

the app in question. 

There is also a folder for the DME app. This folder is called 

Attachments (saved) (highlighted below). Tap a folder to view the 

files that are associated with that folder: 
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You can now perform various operations on those files - see File 

operations on page 103. 

Tap the + icon at the lower right of the folder list to create a new 

folder or file inside the current application folder. You can for 
instance use subfolders for archiving purposes. Note that the app will 

always save its files in the top folder in the app's directory. See 

Adding files and folders on page 101. 
 

Adding files and folders 

In most folders you can tap the + button to add a new folder or a 

new file or folder: 

 
The screenshot above is taken from the Documents folder on the 

device. Here you can add documents, spreadsheets, and presentations 

if you have a license for DME Viewer/Editor. 
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If you choose New Document, you are asked to name it first. 

 

 What is really happening here is that AppBox copies a Word template 

from the AppBox server component to the folder you're viewing, and then 

you are asked to rename it. 

 

DME Viewer/Editor then starts, and displays the empty document, 

ready for you to enter text. When you are done, tap File > Save to 
save the file. Tap Back to go back to the File Browser. DME 

Viewer/Editor will ask you to save any changes, if you haven't already 

done so. For more about this, see Creating and editing documents 

on page 109. 

In remote locations, you can only create folders (but you can for 

instance create a document on your device and then copy or move it 

to the remote location later). If your permissions on the network do 
not allow you to create a folder in the remote location you are 

viewing, you will get an error if you try. 

The Recent files folder is special, because it only contains references 

to files you have been working with recently. Therefore you cannot 

create files and folders in that folder. 

The Applications folder is also special in the sense that it is managed 

by the other apps in your AppBox. Therefore you cannot create files 

or folders directly in that folder, but you can do so in its subfolders.  
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File operations 

In any file list (except in the root of the Applications folder), you 
can tap the top-right Edit button to perform various operations on 

one or more files in the list. Alternatively, you can long-press a file or 

folder to enable the Edit mode. 

 
In Edit mode, you can tap to select one or more files or folders in 

the list. Note that in remote locations, your ability to work with files 

and folders depends on your permissions in that location. 

1. Tap Cancel to exit the Edit mode. Tapping another location in 

the Locations pane also exits Edit mode. 

In the footer bar, you can choose among the following functions:  

2. Delete: Delete the selected files and folders. Not available in the 

Recent files folder. You are asked to confirm the deletion. 

3. Zip: Zip the selected files and folders. See Zip files on page 104 

for more about this. 

4. Send: Send the selected files by the DME email app. This is only 

available from device locations. When you tap the icon, a DME 

email form is shown. The selected files are already attached to the 
email. Complete the email as normal, and tap Send. Please note 

that the email is not sent immediately - it is sent when you leave 

the AppBox and go to the DME Desktop. 

5. Rename: Rename the selected file or folder. You can only do this 
for one file or folder at a time. Not available in the Recent files 

folder. 

6. Copy: Select one or more files and folders, and tap the Copy 

icon. Then browse to another folder, and tap the Copy here 
button shown in the bottom toolbar. Tap Cancel if you don't 

want to copy the file(s) anyway. Note that folders can only be 

copied between locations on the device. 

7. Move: Select one or more files and folders, and tap the Move 
icon. Then browse to another folder, and tap the Move here 

button. Tap Cancel if you don't want to move the file(s) anyway. 

Note that folders can only be moved between locations on the 

device. 
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8. Select all/Unselect all: Tap the Select all button to select all 

the files in the currently shown folder. Tap it again to unselect all 

files. 
 

Zip files 

 Zipping files 

Tap the ZIP button in Edit mode to add the selected files to a zip 

archive. You can create a zip archive containing both files and folders. 

 

You can protect the zip archive with a password: 

 

This is for instance useful in situations where sending attachments as 

password-protected zip files is mandatory. 

 Unzipping files 

Zip archives can be unzipped in locations on the device only. If you 

want to unzip an archive from a shared network location, copy it to 

Documents first. 

Then simply tap the file. The archive will be unzipped to a folder with 

the same name as the file. If such a folder already exists, you will get 

an error message saying so. To overcome this, rename the zip archive 

before unzipping it. 

If the zip archive contains folders, the folder structure will be retained 

in the new folder. 

If the zip archive is password-protected, you will need to enter the 

password before the file can be unzipped. 
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Opening a file 

Tap a file in the File Browser. If it is supported by DME Viewer/Editor, 
it will be opened inside DME. If the filetype is not supported by DME 

Viewer/Editor, your DME Administrator might have allowed you to 

open this type of file outside of DME, using a native app. Tapping the 

file will open this app automatically. 

With DME Viewer/Editor, you can work with documents of the 

following types: 

Type View Edit Create 

Microsoft Office documents    

Comma-separated value files and plain text 

files 

 
  

Adobe PDF (edit means: annotate text and 

draw freehand text) 

   

Hangul documents (Korean)    

Image files: WMF, EMF, BMP, GIF, JPEG, PNG  
  

You can then edit the document and/or save it to another location. 
For more about this, see DME Viewer/Editor on page 107. If you are 

opening the file from a remote location, the file will be opened in the 

standard iOS internal viewer. The selected viewer is beyond the 

control of DME. 

The file is viewed in full screen. To go back to the File Browser, use 

the AppBox slide-out menu: 
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Favorites 

With version 4.2 of the DME app, the concept of Favorites was 

introduced. With favorites, you can create shortcuts to web pages 
within apps. For instance, if you find yourself opening a web app and 

always browsing to the same page, you can create a favorite by 

tapping the  icon in the slide-out menu or the corresponding star 

icon in the browser toolbar. 

The app asks you to name the favorite. Consider that favorites are 

sorted alphabetically in the Launchpad. 

 
Tap Add to save the new favorite in the Launchpad. Favorite apps are 

marked with a star and the icon of its "parent" app:  

 
Just as you can add favorites, you can delete them again. To do this, 

tap the  icon in the Launchpad toolbar. Favorites are clearly 

marked with a red x. Tapping a favorite deletes it immediately. 

 
Tap  in the Launchpad toolbar when you are done removing 

favorites. 
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DME Viewer/Editor 

DME contains a built-in document viewer and editor - the DME 

Viewer/Editor. We license the technology for this from ENTWRX 

SecureWrx (formerly known as Picsel Smart Office). 

 

If you have access to using DME Viewer/Editor (you must have a 
license, and it must be enabled for you in the DME server 

component), then the internal viewer on your device is disabled while 

you are working in the DME apps, and all supported files (including 
attachments) are opened in DME Viewer/Editor. There are several 

advantages of this: 

 Security: The attachments never leave the secure DME 

container, and you can be sure that the documents cannot be 

leaked outside the container, either by intent or by accident. 

 Usability: You can use the DME Viewer/Editor to create new 

documents or edit existing documents. 

With DME Viewer/Editor, you can work with documents of the 

following types: 

Type View Edit Create 

Microsoft Office documents    

Comma-separated value files and plain text 

files 

 
  

Adobe PDF (edit means: annotate text and 

draw freehand text) 

   

Hangul documents (Korean)    

Image files: WMF, EMF, BMP, GIF, JPEG, PNG  
  

When you open an attachment from the DME app or a file in the File 
Browser, DME Viewer/Editor is initialized, and the file is shown. A 

toolbar is shown along the top. 

 

The toolbar has the following options: 
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 Back: Return to the list of attachments or the File Browser. 

 File: Save the file, Save the file As, Search for text in the file 

(some file types), and optionally print the file (see below). 

 Undo: Undo the most recent change in the document. 

 More: Lets you manually re-flow the document or view the file in 

3D. 

 Pages: Lets you browse through all pages in the document using a 

carousel view as below. 

 
You can flip through, pinch and zoom the pages. If the top toolbar 

disappears, tap the top part of the screen to bring it back. 

For more information about the options in the top toolbar, see the 

built-in help file by pressing the Menu button > More in the toolbar, 

and then tap Help. 
 

Printing 

To print a document, the setting Allow printing in the DME server 

component must be ON for your device. This setting is controlled by 

the DME administrator. 

Open a document in DME Viewer/Editor, and choose File > Print in 

the toolbar: 
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A screen such as the following appears. 

 
1. Choose the printer you want to send the pages to. Printers are 

set up in your device Settings. If no printers are found, DME 

Viewer/Editor selects Apple AirPrint, and when you tap the 
Print button, you are taken to the device Print settings screen 

where you can set up a printer. 

2. Choose how many copies you want to print. 

3. If the green All pages checkbox is selected, you will be printing 

all pages. 

4. If you only want to print some pages, scroll through the document 
in the preview, and tap the pages you want to print. The green 

mark in the All pages checkbox is removed. To print all pages, 

tap All pages. 

5. Tap Print to send the selected pages to the printer, or Cancel to 

return to the document view. 
 

Creating and editing documents 

With DME Viewer/Editor, you can create new documents and edit 

existing documents. 

Creating documents from the File Browser is described here: Adding 

files and folders on page 101. 
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You can create documents as part of the process of creating or 

responding to an email (or meeting invitation or note). On the DME 
server component, the settings Enable DME viewer and editor 

and Enable editing must be ON for your device. 

To create a new document using DME Viewer/Editor, do the 

following: 

1. Create an email - a new email or by replying to an existing email. 

2. Tap the  icon in the floating toolbar. 

If you are replying to an email, tap  in the top right of the 

Attachments screen. 

3. You can now choose the source of the attachment you want to 

send: 

 
Apart from the picture Library, the Camera, and existing 

Attachments on the device, DME Viewer/Editor enables you to 

create Microsoft Office documents. For information about adding 

existing files, see Adding attachments on page 52. 

4. Pick Word (for example). 

5. You are asked to enter a filename for the new document. 
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The editor will automatically replace spaces in filenames with 

underscores (if your keyboard permits the entry of spaces). 

6. Tap Create (or OK) to open DME Viewer/Editor. 

7. Tap on the page to start typing. 

8. To format text, select the text (tap a word and drag the handles 
that appear). The bottom toolbar (the formatting blade) gives 

access to a number of formatting options. 

 
For more information about options in DME Viewer and Editor, 

tap More > Help in the top toolbar. 

9. Select Back in the editor menu, and tap Yes to save the 

document. You are returned to the DME Attachments screen, 
where the newly created document has been added as an 

attachment to the email. 

 

10. Tap Back to return to the email. 

You can now send the email with the attachments. 
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Integration 

The DME app, the File Browser, and DME Viewer/Editor are tightly 

integrated. This integration allows you to do the following things:  

 Save a document from any AppBox app 

 Open and edit a document from File Browser in DME 

Viewer/Editor 

 Open attachments from an email in DME Viewer/Editor 

 Create a document to be attached to email using DME 

Viewer/Editor 

 Create a document from File Browser in DME Viewer/Editor 

 Save attachments from an email in File Browser 

 Send one or more documents by email from File Browser 

 Save a document from DME Viewer/Editor in File Browser 

You will find that this integration greatly enhances your productivity.  
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Getting out: Hide and exit 
To hide DME, simply tap the Home button. To start DME again, tap 

the DME icon, or double-tap the Home button to switch back to 

DME. 

A setting in DME decides what happens when you press the Home 

button from the DME app: 

1. Either it simply hides DME - this means that you do not log out, 

and you do not need to log back in when you open DME again, 

unless: 

1. The amount of minutes specified in Security settings (see 

Security settings on page 115) has passed since you hid DME. 

2. The operating system stopped DME because the resources 

were required by another app. 

In order to get back to DME without having to log in again, you 

need to use the app switcher (long-press the Back button). 

2. Or it locks DME - meaning that you are required to log in 

whenever you start DME. This is of course the more secure 

setting, and it may be enforced by your DME Administrator. 

You can always log out immediately by selecting Tools > Lock from 

the Desktop. 

See also General settings on page 114. 
 

Removing DME 

If you remove the DME app, all data protected by DME will be 

removed along with the application. This includes any files you have 

stored using DME Viewer/Editor, the File Browser and other AppBox 

apps. 

To remove the DME app, simply long-press the DME icon on the 

Home screen. When the icons begin to jitter, tap the delete badge on 

the DME icon, and confirm. 
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Getting set up: Settings 
When a device connects to the DME server component for the first 

time, a set of default settings for the device is sent to DME on the 
device. This also happens if a new user takes over an existing device. 

These settings represent your company's security policies. 

A number of those settings can only be modified by the DME 

administrator using the DME server component, but some can be 
changed on the device. Those settings are described here. Note that 

the DME administrator may have blocked your access to changing any 

or all of the settings described in the following sections. 

Also, some settings may be missing from your device because you do 

not have a license for the functionality to which they pertain.  

The layout of your Desktop also depends on the settings. For 

instance, if Calendar sync. is disabled in Settings, there will be no 

 icon on your Desktop. 

To access the settings, switch to the Desktop, and tap  > Settings. 
The settings are listed in a number of categories, which are described 

in the following. 
 

General settings 

The General settings are about things that affect the whole app. 

 Phone number 

Tap to enter the phone number of the device. The DME server 

needs to know your phone number for sending SMS messages to 

the device, and for device management purposes. This field is only 
available if your device has a phone module (that is, not Wi-Fi-only 

tablets). 

 Server path 

This is the path (host name, port number, and SSL option) to the 

DME server component. You set this value once, the first time 
you start DME. The server path should rarely be changed, and 

only if your DME Administrator tells you to. A Test connection 

button lets you verify if you entered the information correctly. For 

more information, see Initial login wizard on page 20. 
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 Language 

Tap to select the language of the DME app. The language change 

takes effect immediately. DME currently supports the following 

languages: 

Chinese (simplified), Danish, Dutch, English, French, German, 

Japanese, Norwegian, Russian, Spanish, and Swedish. 

 Home button 

You can choose how exiting the DME app by pressing the Home 

button should affect DME. 

 Lock: Pressing the Home button locks DME - meaning that 
you are logged out of DME. When you later tap the DME icon 

again, you are required to log in. 

 Hide: Pressing the Home button hides (minimizes) DME, 
without logging you out. When you return to DME, you are 

not required to log in (unless the amount of time set as 

Logout timeout has passed in the meantime), but you are 
immediately returned to the screen from which you pressed 

the Home button - but only if you use the app switcher 

(long-press the Back button) to go back to DME. In order to 
log out, you must go to the DME Desktop and tap Tools > 

Lock. 

See also Getting out: Hide and exit on page 113. 

 Allow HTML content 

If this setting is enabled, HTML in emails is permitted. This setting 

is usually controlled by the DME administrator, who may want to 
disable HTML mails under some circumstances. However, if you 

find that any email causes problems, you can try to disable this 

setting and import your mail again by tapping Tools > Reset from 

the Desktop. 
 

Security settings 

The Security settings deal with options that concern the security of 
your data. A number of settings in this category cannot be changed on 

the device, and exist only on the server component. 

 Private key password 

Here you can specify the password for your private key. Your 

private key is used for decrypting encrypted messages sent to you, 
and for signing private messages. If you do not enter a password 

here, you cannot read encrypted messages or sign new messages 

from your mobile device. 
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If you are using Domino, and it is set up with Notes Encryption, 

you must enter the password for your user ID file. 

If your collaboration system is using S/MIME, enter the password 
for your private key in this field. You must also upload your 

personal certificate to the DME server (using myDME).  

For more information about Notes Encryption, S/MIME, and 

myDME, please contact your DME administrator. 

 Logout timeout (min) 

If the device is left untouched, and DME is open, the DME app is 
locked automatically after this number of minutes. The value 0 

means never log out automatically (not recommended). 
 

Email settings 

The Email section deals with aspects of sending and receiving emails.  

 Email sync. 

You must enable this setting to be able to send and receive emails 

in your Inbox and other mail folders. If disabled, emails are never 

synchronized, and the Inbox icon is removed from your Desktop. 

 Days back 

When synchronizing emails, emails from the last number of days 
selected here will be available in the Inbox. This is called the email 

synchronization window. A very high number here will make your 

Inbox respond slower. Remember that you do not need all your 
email on the device - you can always search for emails on the 

server. See Emails (on server) or Finding email on page 46. 

 Send immediately 

Here you can choose what will happen when you tap Send in the 

email creation form. 

If you select No, the new email is stored in the Outbox folder. It 

will not be sent until the next manual or push synchronization. 

If you select Send only, the new email is sent immediately, but 

any new items are not retrieved from the server component. This 

significantly reduces the load on the server and the time it takes 

to synchronize. 

If you select Send & Receive, the new email is sent immediately, 

and a regular e-mail synchronization is performed. 

 Sort order 

Tap this option to set the order in which emails in your email 

folders should be sorted by default. The original default value is by 
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Date (Descending). For more information, see Sorting email 

on page 47. 

 Mail alert, Start, End, Vibrating alert 

Tap Mail alert to select which sound (or no sound) you want 
hear when you receive a new email in the DME app. These mail 

sounds come with the DME app.  

You can also let the device vibrate when you receive a new email 

by enabling Vibrating alert. 

By specifying a time range using Start and End, you can make 
DME be silent about new emails between the times specified to 

respect your work/life balance. Note that DME also respects the 

Do Not Disturb settings in iOS Settings. 

 Signature 

Any text you enter in this field will be appended to all  new emails 
sent from the DME app. You typically use it for adding a signature. 

Note that the DME administrator can add another text to be 

appended to emails, called an E-mail disclaimer (typically containing 
legal text about your company). The signature from this field will 

be added first, and then the email disclaimer will be added by the 

DME server component at the very end of the e-mail (after any 

reply history). 
 

Folder settings 

With the Folder settings you can set synchronization defaults for 
mail folders. You can override the folder settings on a per-folder 

basis. 

 Sync. contents 

If this field is enabled, email synchronization in subfolders is 

enabled by default. The emails are synchronized for the number of 
days specified in the Days back field (only visible when Sync. 

contents is enabled). You can change the setting for individual 

email folders (see Viewing folders on page 48). 

Regardless of this setting, the folder structure as such (without 
emails) is always synchronized between the collaboration system 

and the device. You need the folder structure when choosing 

where to search for emails on the server - see Finding email on 

page 46 - and for moving emails to other folders. 

If you tap Apply to all folders now, any new folder settings you 

have just specified will be applied to all folders immediately.  
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If you have many folders on the collaboration system, we recommend 

that you set up a very restrictive default setting for the Days back 
field for performance reasons, and loosen up on individual folders as 

described in Viewing folders on page 48. 
 

Calendar settings 

With Calendar settings, you can set up the calendar sync window, 

sound options, and whether to show DME events in the native 

Calendar app as well and vice versa. 

 Calendar sync. 

To be able to work with meeting invitations in your Inbox, view 
your calendar, and create events, you must enable this setting. If 

disabled, the Calendar icon is removed from the Desktop, and you 

cannot view your business calendar on the device. 

 Days back 

Here you choose how many days back in time you want to see 
calendar items from. Together with the Days forward field, this 

makes up the calendar synchronization window. The larger the 

window, the longer time it takes to update the calendar. 

 Days forward 

Here you choose how many days ahead in time you want to see 
calendar items from. Together with the Days back field, this 

makes up the calendar synchronization window. The larger the 

window, the longer time it takes to update the calendar. 

 Alarm sound 

If you enable this setting, DME will play the calendar sound 
specified in the Sound field below when displaying a calendar 

alert. 

 Sound 

If the field Alarm sound above is enabled, you can choose which 

sound to play when a calendar alarm goes off. You can choose 

between Reminder and the standard Apple OS Alert. 
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Device Calendar options 

 
With these settings, you can change the security level of how DME 

calendar interacts with the native calendar on your device. 

 Copy to local enabled: This is also called Open mode. DME 

creates a calendar called DME in the local source of the device 
calendar, and shows calendar entries from DME in that local 

calendar. The entries from DME are copied (using one-way 

sync.) to the device calendar, and you can then view your 
calendar entries without having to log in to DME (not really 

secure). 

When you use this mode, appointments in the local DME 

calendar in the device Calendar app must be 
created/updated/deleted from within the secure DME calendar 

in order for the changes to be reflected in Outlook/Notes. 

DME shows a message telling you what is about to happen 

when you use this mode, stating the number of calendar 
entries that will be copied to your local calendar. Tap Copy to 

start the copying process, or Cancel to cancel. 

Note also that if iCloud calendar synchronization is enabled in 

your device calendar, your DME appointments will not be 
visible in the device calendar. This is because Apple iOS hides 

all local calendars when you enable iCloud calendar 

synchronization for some reason. 

 Copy to local disabled: This is also called Secure mode. 
There is no interaction between DME and the device calendar 

- your business appointments are kept secured by DME. When 

you switch to Secure mode, the DME calendar is removed 

from the device calendar with all its appointments. 

When you enable this setting, a message explaining what is going 

to happen will be shown. When you disable it, the change takes 

effect immediately. 

 Show in DME: When enabled, events from the device 
calendar will be shown in the DME calendar also, in the colors 

defined for the device calendars in the device Calendar app to 

set them apart from regular DME events from Outlook/Notes. 
You can even tap them and edit them from within the DME 
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calendar, but when you do so, you are actually using the 

underlying Apple Calendar, not DME. 

See Interaction with the device Calendar for important information 
about and a more in-depth explanation of the implications of Open 

and Secure mode and how iCloud fits into it all. 

 
 

Contacts settings 

With the Contacts settings, you can enable the synchronization of 

contacts, and you can choose to copy your business contacts into 

your native contacts app. 

 Contacts sync. 

You must enable this setting to be able to view your Outlook or 
Notes contacts in the DME Contacts on your device. If disabled, 

contacts are never synchronized, and the Contacts icon is 

removed from your Desktop. 

Device Address Book options 

 Sync. level 

With the setting in this field you can choose DME's level of 
interaction with the native address book on your device - the 

Contacts application. There are three options: 

 Don't use: If you select this option, there is no interaction 

between DME and the local Contacts app - contacts in the DME 
Contacts and in the device Address Book are kept completely 

separate. This lets you keep your business contacts in sync 

with your collaboration system securely in DME. This is also 

called Secure mode. 

Note that if you synchronize your device address book using 

iCloud, the Sync. level option can only be Don't use. This is 

because the Apple iOS does not permit DME to create a local 
group in the device address book when iCloud is enabled. We 

hope that this will change in the future. See Third-party 

contacts on page 80 for more information. 

 Sync. name and phone numbers: If you select this option, 
contacts from DME are shown in a separate group called DME 

in the device (native) Contacts application, but only Name 

and Phone number information. This way, you can keep your 
company e-mail addresses etc. secret, but still be able to see 

who's calling you if the caller is a DME Contact. This is also 

called Mixed mode. 
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When this option is enabled for the first time, any existing 

contacts in a DME group in the local contacts are ignored. 

Changes made to names and numbers in contacts within DME 
(including changes synchronized from the collaboration system) 

are pushed to the device address book immediately. Changes 

made to names and numbers in the device address book, 
including deletions and additions, are synchronized to the DME 

address book before a contact synchronization with the 

collaboration system. Please note that this process may take 
some time if you have many contacts, and we therefore 

recommend that you only maintain your contacts from DME. 

 Sync. all fields: If you select this option, contacts from DME 

are shown in a separate group called DME in the device 
(native) Contacts application. Contacts in this group are kept 

synchronized with the DME Contacts This is also called Open 

mode. 

When this option is enabled for the first time, and there are 
any existing contacts in a DME group in the local contacts, you 

are asked if you want to Import or Delete the existing 

contacts. Import contacts will import all local contacts to the 
DME group of contacts, and then delete the originals. Delete 

will delete all contacts that are not in the DME group of 

contacts. 

Changes made to contacts within DME (including changes 
synchronized from the collaboration system) are pushed to the 

device address book immediately, to the extent that the native 

Contacts application supports the DME address book fields. 
See Working with contacts on page 78 for more about 

address book fields. Changes made to contacts in the device 

address book, including deletions and additions, are 
synchronized to the DME address book before a contact 

synchronization with the collaboration system. Please note that 

this process may take some time if you have many contacts, 
and we therefore recommend that you only maintain your 

contacts from DME. 

When you use Open/Mixed mode, you can access your business 

contacts without having to log in to DME. Or, to put it in another 

way, your contacts are no longer secured by DME. 

Switching modes 

If you switch to the Don't use option (Secure mode) from one of 

the other two options, DME will delete any contacts in the DME 

group of the Contacts application immediately, including the DME 

group itself. 
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When you switch from Secure mode to either Mixed or Open 

mode, DME shows a message describing what happens next: That 
the DME group is created, and how many contacts will be copied 

from the secure DME contacts to the device contacts. Tap 

Synchronize to carry out the switch to Open/Mixed mode, or 

Cancel to go back. 
 

To-do settings 

With To-do settings, you can set up the to-do sync window. 

 To-do sync. 

To be able to view and create to-dos (tasks), you must enable this 
setting. If disabled, you cannot view your to-dos on the device, and 

the To-do icon is removed from the Desktop. 

For more about how the synchronization window (which is set 

using the options below) is calculated, see To-dos on page 81. 

 Days back 

Here you choose how many days back in time you want to see 
to-do items from. Together with the Days forward field, this 

makes up the to-do synchronization window. The larger the window, 

the longer time it takes to update the to-do list. 

 Days forward 

Here you choose how many days ahead in time you want to see 
to-do items from. Together with the Days back field, this makes 

up the to-do synchronization window. The larger the window, the 

longer time it takes to update the to-do list. 
 

Notes settings 

With Notes settings, you can set up the sync window for Notes 

(journals). This applies only to Domino users. 

 Notes sync. 

To be able to view and create Domino Notes (journals), you must 

enable this setting. If disabled, you cannot view your notes on the 

device, and the Notes icon is removed from the Desktop. 

 Days back 

Here you choose how many days back in time you want to see 

notes from. Together with the Days forward field, this makes up 
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the notes synchronization window. The larger the window, the 

longer time it takes to update the list of notes. 

 Days forward 

Here you choose how many days ahead in time you want to see 
notes from. Together with the Days back field, this makes up the 

notes synchronization window. The larger the window, the longer 

time it takes to update the list of notes. 
 

Feeds settings 

With the Feeds settings, you can set a maximum number of RSS feed 

articles to keep on your device - the feed synchronization window. 

 Feed sync. 

This setting must be enabled if you want to use the RSS feed 
reader. For more about this, see Feeds on page 83. If disabled, the 

Feeds icon is removed from the Desktop. 

 Max. articles in feed 

With this setting you can determine how many articles per RSS 

feed should be kept on your device. This is the feed sync window. 

You can choose among 50, 100, or Unlimited. 
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Getting help: Help desk 

and support 
If you have read this guide and still have questions concerning the 

function and use of the DME app, please contact your Helpdesk 

(usually the internal IT department). 

Before contacting your DME administrator, be sure to have 

information about your DME version etc. ready. 

 Supplying support information 

To find the version number of your DME app: 

1. From the DME Desktop, tap  > About DME. 

This screen shows you release information about your app. 

DME keeps a log of the events that take place in the client. Your 
Helpdesk may ask for information from this log. To see it, do the 

following: 

From the DME Desktop, tap  > Log. 

 

1. Tap Export log  to add the log text as an attachment to a 

new e-mail. 

2. Send the log to your Helpdesk. 

Note that the DME administrator may also retrieve the log from the 

DME server component interface. 
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